
AGENDA 
ACCESSIBILITY AND DIVERSITY, EQUITY AND INCLUSION ADVISORY COMMITTEE 

To be held at Saanich Municipal Hall 
Committee Room 2 and via MS Teams 

Wednesday October 01, 2025 at 5:00 PM 

The District of Saanich lies within the territories of the lək̓ʷəŋən peoples represented by the Songhees 
and Esquimalt Nations and the W̱SÁNEĆ peoples represented by the Tsartlip, Pauquachin, Tsawout, 

Tseycum and Malahat Nations. 

We are committed to celebrating the rich diversity of people in our community. We are guided by the 
principle that embracing diversity enriches the lives of all people. We all share the responsibility for 

creating an equitable and inclusive community and for addressing discrimination in all forms. 

A. COMMITTEE BUSINESS ITEMS

1. CHAIR’S REMARKS

• UBCM 2025 Convention Update

2. SUNFLOWER CAMPAIGN

• Follow-up to September 3, 2025 meeting

3. ACCESSIBILITY GUIDELINES

• Presentation from accessibility consultants Marco Pasqua and Karin Pasqua from
Meaningful Access Consulting, and the accessibility consultant Noah Senecal-
Junkeer from Easy Surf Consulting.

4. ACTION LIST 

B. ADJOURNMENT

Next Meeting: November 05, 2025 at 5:00 PM 
In order to ensure a quorum, please contact Angela Hawkshaw at 250-475-5494 ext. 3505 or 

angela.hawkshaw@saanich.ca if you are unable to attend. 
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ADEI Advisory Committee Report 

Recommendation 

That the ADEI Advisory Committee ask Saanich Council to direct staff to: 
● Have the District of Saanich join the Hidden Disabilities Sunflower Campaign,
● Take the necessary steps to implement the distribution of sunflower lanyards and

other materials in public facilities in the district,
● Include instruction on how to engage with people who choose to identify a hidden

disability by wearing a sunflower lanyard in staff training.

Executive Summary 

The adoption of the Hidden Disabilities Sunflower Campaign represents a practical, 
compassionate, and policy-aligned step toward enhancing accessibility and inclusion in 
the District of Saanich. This initiative would allow individuals with non-visible disabilities 
to identify themselves in a discreet, voluntary manner, enabling municipal staff to 
provide more empathetic and responsive service. By participating in the campaign, 
Saanich would join a growing network of municipalities, public institutions, and 
transportation hubs already embracing the Sunflower as a tool for equity and inclusion. 

Implementing the Sunflower campaign would directly support Saanich’s Accessibility, 
Diversity, Equity, and Inclusion objectives and reinforce commitments set out in the 
Official Community Plan. It would also demonstrate meaningful progress toward 
removing social and attitudinal barriers that still limit full participation for many 
community members. With a modest investment in materials and staff training, Saanich 
can significantly improve the daily experiences of residents living with hidden 
disabilities. 

For these reasons, the ADEI Advisory Committee requests that Saanich Council to 
direct staff to have the District of Saanich join the Hidden Disabilities Sunflower 
Campaign, and to take the necessary steps to implement the distribution of sunflower 
lanyards and other materials in public facilities in the district and to train staff on how to 
engage with people who choose to identify a hidden disability by wearing a sunflower 
lanyard. 

Background: Hidden Disabilities in Canada 

Hidden or non-visible disabilities, also known as invisible disabilities, include a wide 
array of conditions that are not immediately apparent but significantly affect a person’s 
daily life. These can range from mental health conditions (e.g., anxiety, depression, 
PTSD), learning and cognitive disorders (e.g., ADHD, autism, dyslexia), chronic pain, 
fatigue, and episodic illnesses, to neurological conditions, hearing or vision challenges, 
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and other chronic health issues.1 Individuals with hidden disabilities often face unique 
barriers because their needs may not be immediately recognized, leading to 
misunderstandings, skepticism, or inadequate accommodations. 
 
According to the 2022 Canadian Survey on Disability, 27% of Canadians aged 15 and 
older (about 8 million people) have at least one disability that limits daily activities, up 
from 22% (6.2 million) in 2017.2 Of those with disabilities, 39% reported a mental health-
related condition, the largest increase among disability types since 2017.3 Additionally, 
10.4% of Canadians (nearly 3.1 million individuals) had a mental health-related disability 
in 2022, and over half of them experienced attitudinal barriers resulting from 
misconceptions or assumptions in the preceding year.4  
 
These statistics highlight the growing prevalence and impact of hidden disabilities 
across Canadian society. Attitudinal barriers are substantial: 37% of Canadians with 
disabilities encountered obstacles due to others’ behaviours, misconceptions, or 
assumptions, many in everyday interactions or while accessing public services.5  
This underscores the need for programs, like the ‘Hidden Disabilities Sunflower,’ that 
signal hidden needs and foster more understanding, inclusive, and accessible municipal 
services. 
 
The Hidden Disabilities Sunflower Campaign 
 
The Hidden Disabilities Sunflower is a globally recognized initiative that empowers 
individuals with non-visible disabilities to discreetly signal their needs for extra time, 
understanding, or quiet support. Originating in 2016 at Gatwick Airport in the UK, the 
Sunflower, a distinctive green lanyard adorned with yellow sunflowers and optional 
accompanying ID card, enables wearers to be “discreetly seen” by staff trained to offer 
additional assistance. 

 
1 Government of Canada. (2024 June 10). “A way with words and images: guide for communicating with and about 
persons with disabilities.” Available at https://www.canada.ca/en/employment-social-
development/programs/disability/arc/words-images.html  
2 Statistics Canada. (2024 April 3). “The disability rate in Canada increased in 2022.” Available at 
https://www.statcan.gc.ca/o1/en/plus/5980-disability-rate-canada-increased-2022  
3 Statistics Canada. (2024 April 3). “The disability rate in Canada increased in 2022.” Available at 
https://www.statcan.gc.ca/o1/en/plus/5980-disability-rate-canada-increased-2022  
4 Statistics Canada. (2025 January 22). “Mental health-related disabilities, 2022.” Available at 
https://www150.statcan.gc.ca/n1/pub/11-627-m/11-627-m2025010-eng.htm  
5 Hachouch, Y. et al. (2025 January 27). “Barriers to accessibility related to behaviours, misconceptions or 
assumptions: Findings from the 2022 Canadian Survey on Disability.” Statistics Canada, Reports on Disability and 
Accessibility in Canada. Available at https://www150.statcan.gc.ca/n1/pub/89-654-x/89-654-x2025002-eng.htm  
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Participation in the program is entirely voluntary and does not require individuals to 
disclose the nature of their disability. The symbol is intentionally discreet yet 
recognizable to trained personnel, making it especially valuable in settings where 
hidden disabilities can otherwise go unnoticed. Organizations that participate in the 
campaign distribute lanyards and related materials free of charge to community 
members, helping to create a more inclusive and supportive public environment. 
 
The Hidden Disabilities Sunflower organization is a UK-based social enterprise that 
manages the global Sunflower campaign. Organizations join by paying a yearly 
membership fee ($2,940). Organizations that become Sunflower members gain access 
to comprehensive support materials, including digital toolkits, brand guidelines, posters, 
and webinars designed for staff training. These resources enable staff to: 
 

● Recognize the Sunflower lanyard and associated signage; 
● Respond with discrete, empathetic service, offering extra time, quieter spaces, 

gentle communication, or simplified directions; 
● Respect privacy by asking, “How can I help you today?” rather than making 

assumptions  
 
Member organizations also receive modular training and best practice guidance, 
including scenario-based learning and role-play exercises, which Saanich staff can 
adapt to create a bespoke “made in Saanich” toolkit to train staff for the local Saanich 
context and staff needs. The compulsory training video is less than 9 minutes in length, 
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and it explains hidden and non-visible disabilities, the Sunflower, and what to do if you 
see someone wearing one. There is an optional 10 minute video sharing Sunflower 
Wearers lived experience. Staff that are trained in this way can wear a white pin or 
lanyard identifying themselves as a supporter/someone who can be approached for 
assistance.  
 
The sunflower campaign offers additional training opportunities. The most basic entails 
a short introduction video and a 10 minute video about people’s lived experiences with 
hidden disabilities and the campaign. Additional materials are available from the 
campaign that provide more information on how to support folks with sixty different 
conditions, developed in collaboration with people with these conditions. These are 
valuable resources that can help support staff learning and save the District 
considerable time and resources developing their own guidance.  
 
The campaign also hosts numerous drop-in webinars and training sessions, and 
members are entitled to a 30-minute guided session each year. The Sunflower 
campaign recommends that at least 80% of front-facing staff receive the basic training 
before the campaign is launched to the public. 
 
Member organizations can purchase official Sunflower products (lanyards, pins, cards, 
etc.) at bulk rates. 
 
Sunflowers Around the World 
 
The Sunflower has seen widespread adoption: over 300 airports, airlines, transit 
systems, retail chains, and civic institutions globally use the emblem, including major 
Canadian airports like Toronto Pearson Airport, Vancouver International Airport, 
Montréal-Trudeau Airport, and the Victoria International Airport.6 Around the world, 
hotels chains, universities, companies, local governments, conventions, healthcare 
facilities, stadiums and other actors/spaces provide sunflower lanyards at their sites.7 
Lego has even introduced a minifigure wearing a sunflower lanyard.8   
 
The benefits of adopting this program include improved customer confidence, reduced 
anxiety, fewer service delays, better staff interactions, and greater autonomy for people 
with hidden disabilities. By simply allowing wearers to be identified as someone who 
may need a little more assistance, the system fosters compassion without demanding 
disclosure, shifting public services toward truly inclusive engagement. 

 
6 Hidden Disabilities Sunflower (n.d.). “Air Canada are first airline in North America to launch the Sunflower.” 
Available at https://hdsunflower.com/us/insights/post/air-canada-are-first-airline-in-north-america-to-launch-the-
sunflower; and see Victoria Airport Authority. (2024 November 14). “Victoria Airport Authority (VAA) Launches 
Hidden Disabilities Sunflower Program.” Available at https://yyj.ca/victoria-airport-authority-vaa-launches-hidden-
disabilities-sunflower-program/?langselected=1  
7 Hidden Disabilities Sunflower (n.d.). “News.” Available at https://hdsunflower.com/us/insights/category/news  
8 See Wood, Z. (2024 December 3). “New Lego characters aim to represent hidden disabilities such as autism.” The 
Guardian. Available at  
https://www.theguardian.com/lifeandstyle/2024/dec/03/lego-introduces-characters-wearing-hidden-disability-
sunflower-lanyard  
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One Times Colonist news story, reporting on the impact of the program for Vancouver 
International Airport, which distributed over 4,000 lanyards in the first two years of the 
program, described how the sunflower program significantly reduces stress and 
uncertainty by reducing “explanation stress” and promoting more consistent service 
delivery tailored to individuals’ needs.9 
 
Sunflowers in Saanich 
 
To implement the Hidden Disabilities Sunflower Campaign in Saanich, a phased in 
approach is recommended. Many organizations choose this approach, and some may 
roll out the program internally at first, in order to give employees time to familiarize 
themselves with the program. Different phased in approaches can be explored in order 
to ensure a smooth and effective roll out. We can either explore rolling out the program 
internally or choose one or more facilities for an initial implementation. 
 
A phased approach could begin with a pilot at one or two recreation facilities, followed 
by an evaluation period and subsequent expansion. This would allow for feedback 
gathering, refinement of training, and logistical preparation before broad 
implementation. Ultimately, the rollout strategy, including phasing, training delivery, and 
communications, should be developed by staff based on operational considerations and 
in alignment with Saanich’s accessibility and inclusion goals. 
 
Participating facilities would be stocked with sunflower lanyards, which would be made 
available free of charge to community members who wish to use them. Staff at these 
facilities would be trained to recognize the Sunflower symbol and respond with 
understanding, flexibility, and discretion; offering extra time, clear communication, 
alternative navigation options, or simply a compassionate approach. Staff training in this 
way are given the option of wearing a white pin, which helps identify them as someone 
who supports the program, as compared to a green lanyard or pin, which identifies 
someone with a hidden disability.  
 
Budgetary Implications 
 
Participating in the Sunflower campaign involves paying a small annual membership fee 
to join and gain access to the campaigns IP ($2,940), providing staff with appropriate 
training (included in membership fee and not particularly time consuming), and the 
purchase of necessary lanyards and pins. Members get access to bulk rates for 
purchase lanyards and pins.  
 
It is hard to calculate the exact number of lanyards and pins that may be needed for any 
given facility and for a wider rollout overall. The exact number depends on a number of 
factors that include the number of unique visitors, awareness of the program, and the 

 
9 Hui, V. (2024 May 6). “YVR support for hidden disabilities reduces 'explanation stress'.” Times Colonist. 
Available at https://www.timescolonist.com/transportation/yvr-support-for-hidden-disabilities-reduces-explanation-
stress-8706106  
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demographics of visitors. Phasing in the program will provide greater insight into the 
number of lanyards and pins that may be distributed in any given year/for any given 
facility.  
 
A phased approach will permit us to better understand the cost of the program. 
Speaking with people from the Sunflower Campaign, they report that a bulk order of 250 
lanyards costs $939.75 (or $3.76 a lanyard), and 25 pins costs $55.  
 
Additional Requirements 
 
To support implementation, a communications and awareness campaign should 
accompany the rollout. This would include visible signage in participating facilities, 
information available on Saanich websites, and in printed materials, and public outreach 
through the District’s communication channels such as social media, recreation guides, 
and e-newsletters. The Sunflower Campaign provides some of these materials as part 
of membership, and works with members to design and approve communications and 
outreach materials.  
 
The awareness campaign would serve two key functions: informing residents about the 
availability and purpose of the sunflower lanyards, and educating the broader public and 
staff on the importance of respectful and inclusive interaction with people who may be 
navigating non-visible disabilities. 
 
Staff will also need to complete the short training associated with this program. This can 
be incorporated into other existing training opportunities and included in new employee 
onboarding materials.  
 
Sunflowers and Saanich Values 
 
The Hidden Disabilities Sunflower Campaign directly supports and enhances multiple 
pillars of the District of Saanich’s Official Community Plan (OCP), as well as our 
Accessibility Plan.  
 
With respect to the OCP, this policy fits directly into Section 13, Community Well-being. 
The objectives of this section include:  
 

1. Foster a diverse, equitable and inclusive community where all residents are 
engaged and feel a sense of belonging. 

 
2. Provide a range of recreation, arts, and culture opportunities for people of all 

ages, cultural backgrounds and abilities. 
 

3. Recognize First Nations heritage and the community’s colonial past as part of 
Saanich’s path towards reconciliation. 
 

4. Create a healthy, safe, and resilient community. 
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5. Incorporate heritage resources and values into planning and placemaking. 

 
Specific policies within the OCP that are supported by this initiative include: 
 

13.1.2 Continue to work with Neighbourhood Associations, service organizations, 
sports groups, businesses and other stakeholders to support and strengthen the 
community. 
 
13.1.7 Encourage and support a wide range of educational and learning opportunities 
which aid in community capacity building and strive to meet a broad range of 
community needs. 
 
13.1.8 Continue to encourage resident involvement in civic affairs. 
 
13.2.3 Review recreational programming and facilities, as necessary, to ensure they 
are meeting current and emerging needs. 
 
13.2.4 Ensure District recreation facilities and programs are accessible to people of 
all ages, ethnicities, incomes, and abilities. 
 
13.2.6 Undertake awareness building and education programs to encourage 
individuals to develop and maintain an active and healthy lifestyle. 

 
The Sunflower initiative clearly aligns with these goals by proactively creating an 
environment where individuals with hidden disabilities can more confidently and 
comfortably access municipal services, resources, and spaces without needing to 
disclose personal details. 
 
With respect to Saanich’s Accessibility Plan, the sunflower lanyards program is 
particularly well-suited to helping tackle attitudinal and informational communications 
barriers, but could also help tackle systemic and sensory barriers, as well as other 
barriers. The Accessibility Plan notes that “The District of Saanich strives to create an 
inclusive and welcoming culture, where people of all ages and abilities feel included and 
can equally access the facilities, services, programs and information. In our daily work, 
we endeavour to apply an accessibility lens to all aspects of what we do.”10  
 
The plan outlines a number of objectives that are directly supported by this program. 
These include:  
 
1.1 Ensure information relative to accessibility is available to the public and employees. 
 
1.2 Promote inclusive behaviors and support employee knowledge and awareness of:  

● the needs of people with various disabilities.  

 
10 District of Saanich. (2023 December 11). “District of Saanich Accessibility Plan 2023 - 2026.” Available at 
https://www.saanich.ca/EN/main/local-government/accessibility-diversity-equity-inclusion/accessibility-plan.html  
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● accessibility barriers and strategies. 
 
1.2.1 Provide training to new and existing employees on the following topics: 

● why accessibility & inclusion matters; 
● accessibility legislation 
● types of disabilities, invisible disabilities, and intersectionality; 
● barriers to accessibility & inclusion: attitudinal, physical/environmental, 

communication, technological, systemic and sensory; 
● strategies for minimizing barriers to accessibility and inclusion; and 
● inclusive language and creating a sense of belonging. 

 
1.2.3 Provide training in disability awareness as it relates to emergency 
preparedness. 

 
1.2.5 Create an effective model for staff training to support persons with 
disabilities that are in Saanich Parks, Recreation and Community Services 
programs.  

 
2.1 Improve the physical accessibility in Saanich facilities to ensure persons with 
disabilities can access services and gain employment with the District of Saanich.  
 
3.1 Create policies, procedures and tools to support inclusivity, accessibility, and safety.  
 

3.1.4 Create standardized guidelines for accessibility which will inform the 
procurement of goods, services, and facilities. 
 

 
Conclusion and Recommendation 
 
The adoption of the Hidden Disabilities Sunflower Campaign represents a practical, 
compassionate, and policy-aligned step toward enhancing accessibility and inclusion in 
the District of Saanich. This initiative would allow individuals with non-visible disabilities 
to identify themselves in a discreet, voluntary manner, enabling municipal staff to 
provide more empathetic and responsive service. By participating in the campaign, 
Saanich would join a growing network of municipalities, public institutions, and 
transportation hubs already embracing the Sunflower as a tool for equity and inclusion. 
 
Implementing the Sunflower campaign would directly support Saanich’s Accessibility, 
Diversity, Equity, and Inclusion objectives and reinforce commitments set out in the 
Official Community Plan. It would also demonstrate meaningful progress toward 
removing social and attitudinal barriers that still limit full participation for many 
community members. With a modest investment in materials and staff training, Saanich 
can significantly improve the daily experiences of residents living with hidden 
disabilities. 
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For these reasons, the ADEI Advisory Committee requests that Saanich Council to 
direct staff to have the District of Saanich join the Hidden Disabilities Sunflower 
Campaign, and to take the necessary steps to implement the distribution of sunflower 
lanyards and other materials in public facilities in the district and to train staff on how to 
engage with people who choose to identify a hidden disability by wearing a sunflower 
lanyard. 



Hidden Disabilities Sunflower
A robust program to improve accessibility 
for those with hidden disabilities 

Sept 3, 2025



Agenda

1. Impact
2. Program Details
3. Commitment
4. Q&A



MAKING THE INVISIBLE VISIBLE

Global Community
We are officially represented in 56 countries

Approximately 
35% of people 
with disabilities 
use the Sunflower
in the UK

Used in over 

90 
countries

Aviation: 337 airports and 23 airlines worldwide
Healthcare: over 500 health organizations including 
78 hospitals
Education: over 800 schools, colleges and universities

3 
islands

32 
cities

116 
states & 
councils

Over

800 
Charity Sunflower 
Members

Sunflower Members



Some of the challenges

*2020 Hidden Disabilities Sunflower survey of 1,771 people in the UK. 

I worry about what 
people must think 
if they see me in 
the street having a 
sensory overload.”

“



Sunflower Wearer Jaden says

“Knowing what to expect, I’ll be prepared…

I want to encourage others with special needs to 

feel more confident.”

Collaboration between Sunflower Member 

Ottawa International Airport and the 

Children’s Hospital of Easter Ontario (CHEO)
https://www.instagram.com/reel/DHbo9EaRvZ6

https://www.instagram.com/reel/DHbo9EaRvZ6/?hl=en


What is the impact of the Sunflower?

Customer 
Retention

Happy customers 
spend more time 
more often with you

Customer 
Acquisition

Increase demand and 
strengthen word of 
mouth referral

Risk 
Mitigation

Reduce the number of 
preventable incidents

Staff 
culture

Staff are more likely to join 
and stay with a socially 
aware organization

Over 90%
Would be more likely to visit a 
Sunflower-friendly destination

Check whether a venue supports 
the Sunflower before visiting them

95%
Would recommend a venue 
that recognises the Sunflower

Up to 70%
Sunflower Wearers say:



Airports around the world – as of May 20, 2025



Airports in Canada



MAKING THE INVISIBLE VISIBLE

The Sunflower in Canada

Aviation: over 25 airports and 2 airlines; third party planning launch

Transit: 4 transit agencies, another imminent; ferry services 

Municipalities: Regions, cities, and towns

Attractions: Park, Zoo, Farm

Event spaces: Convention centres planning launches coast to coast

Charities: Building relationships with numerous charities

Finance: Major bank internal launch

Sunflower Members



MAKING THE INVISIBLE VISIBLE

Agenda

1. Impact
2. Program Details
3. Commitment
4. Q&A



Corporate Membership helps you

Build BRAND equity

Attract & retain EMPLOYEES

Better serve RESIDENTS

1

2

3

*Corporate membership is our top national membership level and includes all sectors.



Build brand equity

BRAND

• Associate your community with the 
Sunflower and be seen as a Canadian 
organization leading accessibility 

• Do more than meet regulatory requirements

• Effectively share the Sunflower program​ 
building brand awareness and equity for 
both your brand and the Sunflower program

1



Attract and retain employees

EMPLOYEES

• Foster a disability-inclusive culture to 
attract talent and invite increased employee 
engagement and retention

• Easily keep the Sunflower program 
in your employees’ minds

• Learn about relevant workplace considerations

2



Better serve customers

CUSTOMERS

• Provide an accessible and inclusive experience 
to attract the loyalty and significant spending 
power of disabled residents and their families

• Continuous learning to offer richer support

• Access insights to drive product and service 
innovation

3



Awareness Training – Short Videos

Awareness 
Training 

Access the 
10-minute film 
with Sunflower 
wearers sharing 
lived experience in 
addition to the 
9-minute 
animated video. 
Use either or both.

IMPLEMENTATION



Development*

4 informative 
webinars 

30 minutes plus Q&A

Insightful sessions to 
better understand 
hidden disabilities and 
explore strategies for 
greater inclusivity.

Sunflower 
Training**

Disability-
inclusive 
language

Four 
hidden 
disabilities

Communication

* Topics subject to change. Additional topics available for a fee.
** Exclusive to your organization



Access the invisible disabilities index

Development

Invisible disabilities index – example – Multiple Sclerosis

Access the Sunflower Conversations

https://hdsunflower.com/ca/insights/category/invisible-disabilities
https://hdsunflower.com/ca/insights/category/sunflower-stories


Access the invisible disabilities index

Development

Invisible disabilities index
– full access

• Overview of most common symptoms

• Barriers in Everyday Life

• How to Assist

• Making the Workplace Accessible

Short form video clips 

Access the Sunflower Conversations

https://hdsunflower.com/ca/insights/category/invisible-disabilities
https://hdsunflower.com/ca/insights/category/sunflower-stories


Sunflower Team Support

STRATEGY

Account management 

Clare Kumar, proud sunflower wearer and supporter

Discuss objectives and strategies to meet them.

Quarterly Sunflower Meetings

• One-hour live Zoom meeting with other members and those interested in 

joining. Register here.

• Sunflower update – recording available for Corporate members only

• Member highlight – recording available for Corporate members only

• Q&A – not recorded – safe space for open conversation

https://us06web.zoom.us/meeting/register/bZgF4UHwQJaQT9Dkdnd3Dw


Sunflower Team Support

Onboarding Call and Order support – Tasha  Aiken

Facilitated introduction to your account

Marketing & communications support – Holly Tyrer 

Launch support, social media shares, featured articles

Account support – Rebecca Mears 

Location mapping support, Online account support

IMPLEMENTATION



Agenda

1. Impact
2. Program Details
3. Commitment
4. Q&A



Commitment 

Commit to provide ongoing awareness
   of at least 80% of your workforce.*

Provide Sunflower Wearer products to  
       colleagues and residents free of charge.

Submit Sunflower-related
        marketing and communication 
        materials for review and approval.

1

2

3

* Awareness training must be completed prior to any public launch to avoid Sunflower wearer disappointment and collective brand damage.



Corporate membership benefits 

• 15% Discount on all products

• Complimentary 

Corporate Starter Pack 

– value $278.25

PRODUCT



Access the shop in Canada

Raising Awareness Onsite

Complimentary 
Signage

Digital signage is offered at no 
charge. We recommend a mix of 
digital and analog signage to 
accommodate those who have 
difficulty reading screens. Bilingual 
products are under development. 
Customization is available for a fee.

* Prices here noted in CAD as at January 12, 2025. Before any applicable discounts. Please refer to websites for current pricing. Website pricing shall prevail. 

Door decals*

Printables

https://hdsunflower.com/ca/shop/members.html?product_list_limit=40


Access the shop in Canada

Investment

Annual subscription fees Canada - $2,940 CAD (+ tax) per year

* Prices here noted in CAD as at January 12, 2025. Before any applicable discounts. Please refer to websites for current pricing. Website pricing shall prevail. 

https://hdsunflower.com/ca/shop/members.html?product_list_limit=40


Access the shop in Canada  
Access the shop in the

Investment

100 Lanyard + ID cards + Covers
- $464.00
Effective Unit price $4.62

10 Lanyards - $16.80
Effective Unit price $1.68

Sunflower Member Wearer products* 

50 Wearer pins - $120.75
Effective Unit price $2.41

100 Clear wallets - $126.00
Effective Unit price $1.26

250 Custom branded - $514.50
Effective Unit price $2.06

10 Wristbands – $26.25
Effective Unit price - $2.63

* Prices here noted in CAD as at January 12, 2025. Before any applicable discounts. Please refer to websites for current pricing. Website pricing shall prevail. 

https://hdsunflower.com/ca/shop/members.html?product_list_limit=40


Investment

25 Wearer pins - $37.80
Effective Unit price $1.51

Wristbands 
250 Custom branded - $672.00
Effective Unit price $2.69

25 Non-branded – $78.75
Effective Unit price - $3.15

250 Custom branded lanyards- 
$939.75
Effective Unit price $3.76 

250 Custom branded 
Supporter ID cards - $514.50
Effective Unit price $2.06

Sunflower Member Supporter Products* 

10 Supporter ID cards + Covers 
- $31.50
Effective Unit price $3.15

10 Supporter ID Lanyards - 
$23.10
Effective Unit price $2.31

Access the shop in Canada  
Access the shop in the* Prices here noted in CAD as at January 12, 2025. Before any applicable discounts. Please refer to websites for current pricing. Website pricing shall prevail. 

https://hdsunflower.com/ca/shop/members.html?product_list_limit=40


Investment

Sunflower Member Bilingual Products* 

Access the shop in Canada and search for “bilingual” products. Within each product, select the language option from the dropdown menu.
* Prices here noted in CAD as at January 12, 2025. Before any applicable discounts. Please refer to websites for current pricing. Website pricing shall prevail. 

Pack of 25
Effective Unit price $2.31

Packs of 250
Effective Unit price $3.58

Packs of 250
Effective Unit price $2.56

Packs of 250
Effective Unit price $1.96

In development – let’s 
discuss
Pack of 5-25 (dep size)
Effective Unit price 
From $6.20 - $39.00

Minimum order 100

https://hdsunflower.com/ca/shop/members.html?product_list_limit=40


More examples of Sunflower products
 

Sunflower 
wearers

Product 
name Lanyard

Bespoke 
(with company logo)

ID card with clear 
plastic wallet

Bespoke 
(with company logo

Circular
 pin badge

Silicon 
wristband 

Fabric 
wristband

Chest 
ribbon

Sunflower 
supporters

Product 
name Lanyard

Bespoke 
(with company logo)

ID card with clear 
plastic wallet

Bespoke 
(with company logo

Circular
 pin badge

Silicon 
wristband 

Badge with 
clip and pin

Training guide and 
clear plastic wallet

Sunflower 
Members

Product 
name Front of house sticker

Strut cards 
and roller banners

Business corporate 
Starter pack

Personalised Sunflower posters

A0 A1 A2 A4



We are resolved to improve everyday 
experiences for everyone whose 
needs are not immediately obvious.
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2. Program Details
3. Commitment
4. Q&A



Clare Kumar
Regional Director, Canada

clare@hdsunflower.com
647-444-3535

mailto:Clare.k@hdsunflower.com


Hidden
Disabilities 
Sunflower
Making the invisible, visible.

Sarah Moore
Legislative Specialist, 
Corporate Services - Town of Ajax



A little Town called Ajax…



How’d we become 
involved with Hidden 
Disabilities Sunflower?

• Presentation by Metrolinx at ONAP conference
• Brought the information back to Town of Ajax 

Accessibility Advisory Committee and manager



Why it was important:
 Support your diversity and inclusion 

objectives and organizational partnerships

 Increase ‘customer’ inclusion

 Build greater staff awareness of hidden 
disabilities

 Expand recognition of international program 
across public service organizations



From Implementation…
• Two-phased launch

o Internal vs. Public launch

• Internal: during Customer 
Service Week

o Staff e-blast

o Intranet web page

o Launched training requirement

o Started creating promotional 
assets for public launch



…to Public Launch!
~ Approx. 2 months to hit staff 

training completion target  (80%) 

o Now included as part of new hire 
on-boarding

o Facility decals at main entrance

o Front-counter displays

o Promotional Items:

o News release, social media, 
video, web page: 
ajax.ca/sunflower 

https://www.ajax.ca/en/inside-townhall/accessible-programs-and-services.aspx#Hidden-Disabilities-Sunflower-Program


Request Process:
1. Requester completes online form 

(staff are also able to assist with completion over the phone/in-person)

• Name & contact info.
• Is request for your self or on behalf of someone?
• Are you an Ajax resident? 
• Do you reg. access Town facilities/services?
 If no, contact requester to explain the program

2. Requestors can choose one item:
• pin with locking back
• waterproof wristband
• lanyard



Request Process continued
3. Staff review the request and mail out to 

requester (requests processed once/week)

4. Item is sent via regular letter post with a flyer 
about the program, encouraging them to share 
feedback

5. Bulk orders are accommodated on request 
(e.g. Community Living Summer Camp 
program participants)



Q1-3 Summary



12/18/24 – 09/18/25

Volume of requests
278 requests in the first 9 months 
since public launch:

• pin (49%)
• lanyard* (29%)
• waterproof wristband* (22%)

*added option as of July 2025



12/18/24 – 09/18/25 cont.
Interest in the Program

• 48% of requests were made on behalf of a family 
member or friend with an invisible disability

• 61% of requests came from Ajax residents

• 81% of requestors actively participate in Town of Ajax 
programs, services, and facilities

• 84% of requests were sent by mail



Engagement
How did requesters hear about the Town’s 
participation in the program?:

•Social Media – 53%
• Info. displayed in a Town facility – 15%
•Town of Ajax website – 10%
•Word of mouth – 12 %
•Other – 10%



Outreach & Collaboration 
• City of Pickering Accessibility Advisory Committee
• Lakeridge Health Senior Support Programming Staff 
• Residents of Ashley Manor and Westwood Manor (via 

Lakeridge Health Senior Support Group)
• Durham Region Transit 
• Region of Durham Accessibility Ambassadors Group
• Region of Durham Accessibility Coordinators
• Region of Durham Accessibility Advisory Committee
• Ajax Accessibility Fair Event
• Older Adults BBQ
• District of Saanich



Building Awareness
• Summer social media blast for wristband availability (in time for 

aquatics programming and summer camps) 

• Information station at staff luncheon providing wearer and 
supporter materials; “Garden of Inclusion” art project: Staff were 
encouraged to “plant” a sunflower with messages of inclusion 
(106 staff participated in a two-hour period!).



Recognition:
Town of Ajax was thrilled to be recognized as the Accessible 
Employer of the Year at the 2025 Abilities Centre Accessibility 
Awards! (May 2025)

Receipt of this award highlights the Town’s ongoing commitment to 
accessibility and inclusion across our programs, policies, facilities 
and services, like participation in the Sunflower program.



Testimoni
als

Testimonials



Don’t underestimate the internal impact!

Sarah,

This is the best program by far that the Town and you have 
got us involved with. 
Someone like me who is completely deaf on my right side 
and now with an autoimmune disease are truly appreciative 
of this initiative 
Thank you so much for this and although I am on an 
exemption working from home undergoing some medical 
treatment, I would appreciate if you provided me with a pin 
to wear when I return 

Thank you Sarah, great work!!!!!!!!!!!!!!!!



A Quiet Moment of Understanding at Town Hall

Shortly after the Town of Ajax publicly launched its participation 
in the Hidden Disabilities Sunflower Program, a resident entered 
Town Hall wearing a sunflower pin. The individual, who lives with 
a non-visible disability, had come to renew a permit—a process 
that can be stressful and overwhelming due to sensory 
sensitivities and anxiety.

At the front desk, a contracted facility security staff member—
newly trained—immediately recognized the sunflower symbol. 
Instead of the usual brisk check-in, the staff member offered a 
warm greeting, slowed their pace, and gently asked if the visitor 
needed any assistance or extra time. The resident later shared that 
this small gesture made them feel seen and respected in a way 
they rarely experienced in public spaces



Sunfllowers in the Wild!

Hi Sarah. 

Thank you for my sunflower pin. We have just returned 
from two months of travelling, involving several flights. A 
flight attendant on AirTransat noticed my pin and 
recognized it! It is a great programme. The driver of an 
airport "golf cart" also saw it and gave us a ride....very 
much appreciated! I saw several others wearing the 
sunflower lanyard, too. 

Thank you for your understanding and for promoting such a 
helpful programme.



Looking Ahead



Looking Ahead:
• Seeds are sowing!!!

• Durham Region Transit 
• City of Pickering
• Service Durham
• Region-wide? --? goal

• Evaluation & Metrics
• Partnering with DRT to evaluate program participation

• Continued Outreach and Expansion in Ajax
• Supporter materials for staff (lanyards, laptop decals)
• Continuing awareness presentations, promotion



Thinking of joining HDS?



Considerations:
• Budget

• Membership fee
• What items will you provide? (e.g. pins, lanyards, supporter items)

• Keep in mind, items ship from UK (+duties extra, longer to ship)
• ~approx. $3-4 per request including postage

• In-house materials
• Materials created using the Sunflower image require advance approval from HDS 

communications team  need to build review into project timelines

• Demand
• How will you manage requests?

• Centralized through accessibility coordinator; online form, priority access for Ajax residents and 
those individuals who regularly access Ajax facilities and services

• Items delivered by Canada Post mail (1-2 pins covered by regular Canada Post letter postage)

• Growth
• How to keep the program relevant and top of mind both internally and externally



Expenses to date:
Q1 Expenses (Dec. 18 2024 - March 18 2025) Cost CBSA Fees Total
Membership 1,470.00$ -$             1,470.00$ 
100 pins; 10 decals 236.39$    119.29$        355.68$    
Display stands for facility frontline (18) 76.23$      -$             76.23$      
Postage 98.40$      -$             98.40$      

Q2 Expenses (March 19 - June 18 2025)
Postage 39.36$      -$             39.36$      
150 pins; 25 support pin; 50 wristbands 469.91$    124.01$        593.92$    

Q3 Expenses (June 19 - September 18 2025)
Membership renewal 1,550.00$ -$             1,550.00$ 
250 supporter lanyards; 200 wearer lanyards; 
150 laptop decals; 50 wristbands 

1,214.50$ 124.41$        1,338.91$ 

Postage 165.34$    -$             165.34$    

5,687.84$ 

 Graphic design, videography and social media was overseen in-house by Town of Ajax staff
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HDS Canada Contact:

Clare Kumar
(she/her, AuDHD, HSP)
Regional Director - Canada, The 
Hidden Disabilities Sunflower Team
hdsunflower.com
1-647-444-3535
clare@hdsunflower.com

https://cas5-0-urlprotect.trendmicro.com/wis/clicktime/v1/query?url=https%3a%2f%2fhiddendisabilitiesstore.com&umid=9c740ab2-3dca-48a1-8c94-12eb7cbb7ed2&rct=1746555321&auth=467b7641cee18b536c65a05102c72aa38b41200c-eebe1a9ad58dd3e993a4bb56a872b283dcf6eef4
mailto:clare@hdsunflower.com


Questions?
Thank you!

Sarah Moore
Legislative Specialist

Corporate Services 

Town of Ajax

sarah.moore@ajax.ca

905-619-2529, ext. 3347
365-885-2161 (cell)

mailto:sarah.moore@ajax.ca


Intro to document 
accessibility 
Checklist 

General 

Category Guidelines 

Accessible by 
design 

Think about accessibility from the start—like adding 
blueberries before baking muffins. 

Keep it 
simple 

Create simple documents with text, headings, images 
(with alt text), and simple tables (with one header row). 

Text & layout 
Use at least 18pt font for presentations and 12pt for 
other documents. Space out text (1.5 line spacing), keep 
it left-aligned, and break it into short paragraphs. 

Headings 
Use real heading styles in a logical order (H1 for titles, 
H2 for sections, etc.). 

Links 
Write clear, descriptive links (e.g., "Learn more about 
accessibility" instead of "Click here"). Underline and use 
colour so links stand out. 

Images 
Add alt text for meaningful images, mark decorative 
images as such, and include image descriptions when 
more context is needed. 



Tables 
Use tables only for data—not for layout. Keep them 
simple with a single header row. 

Emphasis 
Highlight important info using text like “Important” 
instead of relying only on colour, visual methods, or 
symbols. 

Colour 

Use high-contrast colours and check contrast ratios 
with tools like WebAIM’s contrast checker. Also, avoid 
relying on colour alone to convey information visually or 
in text (e.g., “the items in red”). 

Accessibility 
Checkers 

Use built-in checkers in Word, PowerPoint, Excel, and 
Adobe Acrobat to catch common issues. 

Manual 
checks 

Always double-check accessibility manually—automated 
tools can't catch everything. Review: alt text accuracy, 
proper reading order, and logical content structure. 

 

Word 

Category Best practice 

Headings Use real heading styles and don’t skip levels. 

Table of 
contents 

Use Word’s built-in table of contents to leverage 
headings and ease navigation, especially for speech 
recognition users. 

Lists 
Group related content with real lists to communicate 
structure to assistive technologies and layout content 
intuitively. 

 

https://webaim.org/resources/contrastchecker/


PowerPoint 

Category Best practice 

Design 
themes 

Use built-in design themes for better structure and 
reading order. Avoid complex backgrounds with 
gradients and patterns. Modify colours in Slide Master. 

Slide titles 

Add a clear, distinct title to each slide. This helps all 
users—especially screen reader users—navigate and 
understand the content (Review > Check Accessibility > 
Slide Title). 

Reading 
order 

Add content in logical order and review the reading flow 
with the Selection Pane—title first, then body text. 

 

Excel 

Category Best practice 

Worksheet 
names 

Use unique, descriptive worksheet names instead of 
default “Sheet1” names. Delete unused sheets. 

Cell A1 
Start with Cell A1 for orientation info. Avoid blank A1 
cells. 

Text 
visibility 

Ensure text in cells is fully visible using "Wrap Text" or 
resizing columns. 

Blank and 
hidden 
content 

Avoid blank sheets, rows, and columns. If needed, add 
one blank row to separate tables. Mark intentionally 
blank cells with "No data". Avoid hidden rows and 
columns. 

 



PDF 

Category Best practice 

Word vs. 
PDF 

Provide multiple formats (like Word). Only offer essential 
PDFs (editable forms) to reduce remediation costs. 

Save as PDF 
Use "Save as PDF" with accessibility options enabled—
never "Print as PDF." Steps vary slightly by program. 

Document 
title 

Add a document title under File > Document Properties > 
Description > Title. 

Tag order 

Make sure the tag order follows a logical reading flow for 
screen reader users. Tags at the top are read first, 
regardless of visual layout. Adjust by dragging tags in the 
Tags panel. 

Accessibility 
Checker 

From the All tools pane, go to Prepare for accessibility > 
Check for accessibility > Start Checking. If any issues 
remain, right-click them and select Explain to learn how 
to fix them. 

Table 
headers (if 
needed) 

Table headers might not be tagged correctly when converting to PDF. In 
the Tags panel, ensure each header cell is tagged as <th>, nested inside a 
<tr>, and rows inside a <table>. To fix a tag, double-click and type <th>, 
or right-click > Properties > change the Type to Table Header Cell. 

 

How to open the Accessibility Checker 

Word, PowerPoint, and Excel 

The instructions are the same across Word, PowerPoint, and Excel on 

Windows, macOS, and Web versions. 



1. Select the Review tab. 

2. Select Check Accessibility.

 

The Accessibility pane will open on the right. 

To learn more, see Microsoft’s support article Improve accessibility with the 

Accessibility Checker. 

Adobe Acrobat Pro 

1. From the global bar, select All tools.  

2. From the left panel, select View more > Prepare for accessibility > 

Check for accessibility. 

https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#section-1_tabControl-PickTab=Windows
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#section-1_tabControl-PickTab=Windows


3. From the Accessibility Checker Options dialog, keep all options 

selected and select Start Checking.

 

The Accessibility Checker panel will open on the right. 

To learn more, see Adobe’s support article Create and verify PDF 

accessibility. 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
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How to use this document 
This guide outlines best practices for creating accessible documents. It’s here to 

help you build accessibility in from the start—removing the most significant 

barriers and making your content easier to use for everyone, including people 

who use assistive technologies.  

While it doesn’t cover everything needed for full accessibility conformance, these 

steps will take you a long way and can greatly reduce the time and cost if 

professional support is needed for more complex or important documents. 

General 

Design 

• “Bake in” accessibility from the start: Like adding blueberries before 

baking muffins, build accessibility into your document from the beginning—

not after it’s finished. 

• Create simple documents: Simple is better. Try to avoid complexity and 

stick to text, links, headings, alt text for images, and tables with one header 

row. 



 

5 

 

Text and layout 

• Use readable font sizes: Aim for at least 18pt for presentations and 12pt 

for other documents to keep text easy to read. 

• Use 1.5 spacing: Provide extra space between lines to help users with 

reading or cognitive disabilities track text more easily. Avoid exceeding 2.0 

line spacing in most cases. 

• Stick to left-aligned: It’s the easiest to read as it keeps a consistent 

starting point for each line (for left-to-right languages like English). 

• Use short paragraphs: Keep paragraphs short and focused on one idea. 

This creates white space, makes content easier to read, and encourages 

users to keep going. It’s okay to use a one-sentence paragraph—just not 

too often. 

Headings 

• Use real heading styles: Don’t just use large bold text. 
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• Maintain a logical order: Use Heading 1 for titles, Heading 2 for sections, 

Heading 3 for subsections. Don’t skip levels. 

• Write concise, meaningful headings: Make them clear and informative. 

• Customize styles: Use the “Modify” option to adjust heading styles as 

needed. 

Links 

• Insert real links: Make sure links are interactable. 

• Use clear link text: Describe the purpose or destination. 

• Avoid vague phrases: Don’t use “click here” or “read more.” 

• Style links clearly: Use both underline and colour to set them apart from 

surrounding text. 

Images 

• Add alt text to meaningful images: Not everyone can see images, so alt 

text lets screen readers describe them aloud. 

• Consider image descriptions: You can also add an image description 

directly into your document to ensure its meaning is clear, especially for 

people who may struggle with ambiguity. 

• Mark decorative images appropriately: If you’re keeping the file in Word 

format, type “decorative” as the alt text or use brief alt text for images 

without meaningful content. If you’re exporting to PDF, select “Mark as 

decorative” instead. 



 

7 
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Tables 

• Use tables only for data: Don’t use them for layout. 

• Avoid complex tables: Skip merged cells, multiple header rows, or too 

many columns. 

• Split complex tables: Break them into simpler, smaller tables. 
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• Mark the top row as a header: This helps screen readers read the table 

correctly. 

Emphasis 

• Use text-based emphasis: For example, add “Important" before warning 

text—don’t just use the colour red. 

• Don’t rely on colour or symbols alone: Make sure meaning is clear 

without visual cues. 

 

Colour 

• Don’t rely on colour alone: Avoid phrases like “the items in red.” 
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• Add alternative cues: Use text, labels, symbols, or alt text to convey 

meaning. 

• Use high contrast colours: Check contrast ratios with tools like WebAIM’s 

contrast checker. 

 

https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/contrastchecker/
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Accessibility checkers 

• Use built-in Accessibility Checkers: Available in Word, PowerPoint, Excel, 

and Adobe Acrobat. 

• Start with automated checks: They help spot basic issues quickly. 

• Know their limits: Manual review is still needed for full accessibility. 
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Word 

Headings 

Proper headings help screen reader users navigate and make it easy to generate 

a table of contents. 

• Apply real heading styles: Use built-in styles, not just bold text. 

• Don’t skip heading levels: Follow a logical order (e.g., Heading 2 after 

Heading 1). 

• Customize if needed: You can adjust styles to match your design. 
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Table of contents 

A table of contents gives readers an overview and helps with navigation, 

especially in long documents. 

• Use real headings to create a table of contents: Add one via References 

> Table of Contents > Select a style. 

• Keep it updated: Refresh it after editing to stay accurate. 
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Lists 

Real lists communicate structure to assistive technologies effectively. They also 

group related items and layout content intuitively. 
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• Insert real lists: Use built-in list tools—not tabs, dashes, or manual 

numbering. This ensures screen readers can identify and navigate them 

effectively. 

 

Accessibility Checker 

Use Word’s Accessibility Checker: 

1. Open the tool: Go to Review > Check Accessibility. 

2. Review results: The task pane displays issues, explanations, and 

suggestions. 

3. Fix issues: Follow the steps provided for each error, warning, or tip. 

4. Double check alt text: Edit the automatic alt text to make it concise and 

meaningful. 
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PowerPoint 

Design themes 

● Use built-in themes: They ensure accessible structure and logical reading 

order. 

● Avoid complex designs: Skip background patterns or gradients that 

reduce readability. 

● Modify colours in Slide Master: Fix contrast or readability issues across 

the entire presentation. 

● Add content in logical order: This maintains proper screen reader flow 

(e.g., title first, then body text). 

 

Slide titles 

• Use unique, informative slide titles: This helps all users—especially 

screen reader users—navigate and understand the content (Review > Check 

Accessibility > Slide Title). 
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Reading order 

● Check the reading order: Screen readers follow the order items were 

added to the slide—it might not be logical. 

● Fix it in the Selection Pane: Reorder items so titles come first, followed 

by body text and other content. 
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Excel 

Worksheet name 

• Use unique worksheet names: Make them concise and descriptive to help 

users navigate efficiently. 

• Avoid defaults: Replace names like “Sheet1” or “Sheet2.” 

• Delete unused sheets: This keeps the workbook simple to use. 

Cell A1 

Cell A1 is especially important—it’s the first cell screen readers read. So using it 

well sets the tone for an accessible experience. 

• Use Cell A1 for orienting information: For example, worksheet or 

workbook summaries, the number of sheets, or navigation instructions for 

complex workbooks (an index). 

• Avoid leaving Cell A1 blank: This ensures screen readers announce the 

content on the worksheet. 

• Format text in Cell A1 using “Wrap Text”: This keeps descriptions 

concise and readable without cropping or spilling out. 
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Text 

● Make text fully visible: Avoid cropping or overflowing. 

● Keep content clear, readable, and accessible: Users shouldn’t need to 

scroll or adjust settings to read it. 

● Use “Wrap Text” for longer text: This keeps everything readable within 

the cell. 

● Resize columns and rows for shorter text: This prevents cut-off content. 

Data 

● Avoid blank or hidden content: Screen readers can get stuck or skip 

important information. 

● Use only one blank row between tables: More than one can confuse 

users. 

● Remove unused sheets: This streamlines navigation. 
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● Mark blank cells clearly: Use text like “No data” instead of leaving them 

empty. 

● Avoid hidden rows and columns: They’re hard to detect and can frustrate 

assistive tech users. 

PDF 

File formats 

• Provide multiple formats: PDFs are popular and offer design control but 

often don’t work well with assistive technology. Include an accessible Word 

version. 

• Only offer and remediate essential PDFs: Focus on key documents that 

aren’t just informational, like editable forms. This saves on remediation 

costs. 

• Hire a professional if needed: Especially for important or complex PDFs.  

Approach 

Follow these steps to remove the most significant accessibility barriers: 

1. Make the source document accessible. 

2. Save as a tagged PDF. 

3. Add a document title. 

4. Review the tag order. 

5. Run the Accessibility Checker. 
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6. Fix remaining issues it finds (e.g. table headers). 

Save as PDF 

● Don't “Print as PDF”. 

●  “Save as PDF” instead: 

1. Select  File > Save as Adobe PDF. 

2. In the pop-up dialog, select Options: 

● Check Enable Accessibility and Reflow with tagged Adobe 

PDF 

● Check Convert Word Headings to Bookmarks. 
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Note: Saving as tagged PDF varies slightly across programs. 

Document title 

Screen readers announce a document’s title first, and sighted users see it in the 

title bar. 

• Add a document title: Go to File > Document Properties > Description and 

enter it in the Title field. 
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Tag order 

Tag order controls how screen readers read content, ensuring it’s clear and 

logical. 

• Review the tag order: Screen readers read tags top to bottom. Think like a 

user—what should be heard first? 
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• Adjust as needed: Drag and drop tags to fix the order. 

Note: Tag order affects screen reader flow, not visual layout. 

Accessibility Checker 

From the All tools pane, run the Accessibility Checker: 

1. Select Prepare for accessibility. 

2. Select Check for accessibility. 

3. In the modal, select Start Checking. 

If any issues remain, right-click the issue and choose Explain to see how to fix it. 
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Tables 

Table headers might not be tagged correctly when converting to PDF. They can 

look right visually but still be read incorrectly to screen readers. 

• Check the Tags panel: Make sure headers are correctly tagged and 

nested: 

o Each header cell should be tagged as <th> (table header).  

o Table headers (<th>) must be inside a <tr> (table row).  
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o Table rows must be inside a <table> (table). 

• Add table headers (if needed): To change a tag to a table header: 

o Double-click the tag and type “<th>”, or 

o Right-click the tag > select Properties > choose Table Header Cell 

from the Type drop-down. 

 

Resources 
● Make your content accessible to everyone 

● Make your content accessible in the Microsoft 365 apps 

● Improve accessibility with the Accessibility Checker 

● WebAIM - Contrast Checker 

● Create accessible PDFs - Microsoft Support 

● Create and verify PDF accessibility - Acrobat Pro 

https://support.microsoft.com/en-us/office/make-your-content-accessible-to-everyone-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
https://support.microsoft.com/en-us/office/make-your-content-accessible-in-the-microsoft-365-apps-8a04499b-8a58-4db6-8c9d-5837f60745ef
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows
https://webaim.org/resources/contrastchecker/
https://support.microsoft.com/en-us/office/create-accessible-pdfs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
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Location Selection

GENERAL GUIDELINES

Seating Considerations:

Has accessible or universal washrooms (if there are none, consider renting 
accessible washroom facilities)
Includes an elevator in a multi-story building and step-free access to all main areas 
where then event will be held
Provides ample accessible parking close to entrances
Maintains clear, wide pathways around the venue/event site
Ensure doors are easy to open and have accessible handles or automatic door 
operators.
Has areas of lowered counter space or a table set up with knee clearance at 
ticketing/reception/will-call

Additional Outdoor Considerations
The outdoor ground surface should be level and smooth, noting that concrete, asphalt 
or compacted crushed gravel surfaces are far more accessible than grass or wood chips. 
Wood chips or bark mulch are not accessible surfaces.
Event organizers may wish to install temporary pathways (Mobi mats, plywood etc.) for 
outdoor events especially if the weather has been very wet.
Avoid sites with a more than 5% slope.
Consider providing a “Welcome & Orientation Tent” with accessible maps, large print 
schedules, QR codes for screen reader–friendly versions, and verbal orientation by staff.

When selecting a venue for an event, it’s important to consider the location and 
whether or not the facilities onsite would work for the majority of participants.  Select 
a location that:
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Parking

There is accessible parking near the entrance
Accessible parking ideally includes an access aisle 
connected to a path of travel preventing 
individuals from having to navigate behind parked 
vehicles.
If insufficient numbers of accessible parking stalls 
are available consider providing temporary 
additional parking (especially for large scale public 
events and events that are targeted towards 
seniors)
Ensure that vendors and the event team members 
have dedicated parking including loading areas so 
not that the accessible parking becomes even 
more limited.

Parking, near the entrance and primary event amenities is of key importance.  
Consider the location of the accessible parking stalls and whether or not it meets the 
needs of the attendees of the event.

Seating Considerations:

Emergency Procedures

Emergency evacuation plans include people with disabilities.
Staff and volunteers are trained to assist people with mobility, sensory, or 
cognitive disabilities in emergencies.
Audible and visual alarms are in place (where applicable).
Clear signage or instructions are provided for shelter-in-place locations or 
evacuation maps.

Emergency procedures are important to consider for people with disabilities and 
ideally instructions should be accessible and available in multiple formats.
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Attendee Communications

For all events it is best practice to provide information to attendees on what 
accessibility features are available but particularly at public events.
Let attendees know of:

The location and availability of accessible parking and washrooms.
The availability or ability to request ASL interpretation or alternative format 
materials.
Any additional accommodations such as a sensory friendly space, available 
notetakers etc. or who to contact (email and phone number) regarding an 
accessibility request
Any elements of concern such as strobe lights intense sounds or smells.

For ticketed or registered events, it is always a good idea to ask attendees if they 
have any accessibility needs or accommodations.  It is standard practice to leave this 
question as open ended but if there are limitations to what accommodations can be 
provided then providing the list of selections is also reasonable.

Seating Considerations:

Event Registration

The key factor for event registration is to include the opportunity for an individual to 
highlight their accessibility needs.  It’s important to avoid asking for proof or limiting 
requests related to medical disabilities. Keep it values and trust based.

Use an accessible registration platform. Choose a registration tool that is WCAG 2.1 
AA compliant (e.g., Jotform, Eventbrite with accessibility enabled and 
SurveyMonkey are good examples).
Test for screen reader compatibility. Ensure all form fields are labeled, error 
messages are announced, and users can tab through without getting stuck.
Avoid CAPTCHAs if possible. If needed, offer an accessible alternative (like audio 
CAPTCHA).
State your accessibility commitment.
Send confirmation in an accessible format avoiding Pdfs if possible unless made 
accessible and include details such as the location of accessible entrances and 
washrooms maps with large print and information about accessibility 
accommodations including sensory friendly spaces.

Event registration is the initial point of conversation between an event organizer and 
an attendee and is the perfect place to begin the accessibility journey for the 
attendee.
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Offer a variety of seating options is preferred ideally some with armrests and 
backrests, including spaces for wheelchairs and those with mobility devices.
Reserve accessible seating near entrances and exits for easy access.
Consider seating and table set ups – options can create the greatest amount of 
access for everyone.  

Include both cocktail and standard height tables
Include tables with knee clearance

Accessible seating areas should always include an area adjacent to the 
accessible seating area where a companion can be seated.
Floor length tablecloth can create barriers for people using mobility devices so 
consider using half height tablecloths.
Consider providing a few cushioned resting chairs in low-traffic areas for 
participants who experience fatigue, chronic pain, or postural challenges
If anticipating lengthy lines consider options to provide seating along line up 
areas to assist people with standing for long periods.

Seating
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Gala/Reception Event Considerations
Accessible seating should be located near entrances and exits.
Should a VIP with a mobility device be seated at the front of the room then 
ensuring the path of travel is accessible and sufficiently wide is to be 
prioritized.
Ensure that an individual with a disability is placed at the table at an area 
without a table leg.
Include both cocktail and standard height tables.
If there is a stage or presentation ensure that the accessible seating has clear 
line of sight.
For an individual who is deaf or hard-of-hearing placing them near to the 
front of the room would help with lip reading or viewing the sign language 
interpreter.

Seating Considerations:

Outdoor Considerations
When planning for a festival or an outdoor venue with a stage, consider providing 
an elevated viewing platform for individuals with disabilities which offers direct 
line of site to the stage.

It should be connected to a path of travel and feature a ramp for access and
Feature signage that indicates it’s intended purpose;
Be located near an accessible washroom;
Provide a line of Sight to the stage;
And provide some shade and removable seating for companions.
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ions:

Event Set up

Paths of travel from the entrance to accessible washrooms has been considered
When navigating around a venue there is ample space between tables to allow 
someone to walk comfortably without Accidental injury from someone moving a 
chair quickly.
Are all primary elements of an event reasonably accessible?
Where possible, offer shaded seating along key routes for people to rest while 
navigating longer distances.
Consider scheduling “low-stimulation hours” or quiet windows, especially at all-
ages or family-focused festivals.

Food Service Considerations
Access is considered to any food or beverage stations

Menus and information is easily legible from a seated position
Self service food is at counter height, easily reachable.
Allergens are clearly marked

Provide accessible water fountains or bottle refill stations.
Staff or volunteers are on hand to provide assistance to attendees in serving or 
carrying food and beverage items.

Ticketing or Payment Systems
Ensure point-of-sale is accessible (height, reach, digital interface).
Offer multiple payment methods, including contactless options.
Consider an accessibility discount or free support person pass.

Staging for Award Winners
If people will be asked to approach a stage unexpectedly, ensure:

There's an accessible path (no surprise stairs).
Someone is available to assist, if requested.
A backup plan exists for alternative presentation (e.g., presenter comes to 
recipient).

When selecting a venue for an event, it’s important to consider the Of all of the 
amenities and programming elements.  Consider the path of travel and how 
someone may be able to navigate from the accessible parking stall to the majority of 
the key event spaces.
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Communication Access

Is a hearing loop or other assistive listening device available for the primary 
stage/announcements

A temporary hearing loop can be installed for special events such as galas 
and VIP receptions

Has an ASL interpreter been hired for primary announcements? (An ASL interpreter 
Should be hired for all public events for primary announcements and for ticketed or 
registered events upon request).
Are closed captions enabled?
Has live transcription been considered for large events such as workshops or focus 
groups?

Communication access is particularly important for people who are Deaf or hard-of-
hearing and is equally important for individuals with neurodiversities.  One such 
methodology is providing a hearing loop or other similar assistive listening device in 
key areas where information is communicated. A hearing loop is a form of assistive 
listening device that transmits sound from the AV system directly into someone’s 
cochlear implant or in hearing aids via radio frequencies.

Another key element to communication accessibility is ensuring that anyone 
speaking is using a microphone. Oftentimes people say that they have a loud 
booming voice and choose not to use a microphone however in is best practice that 
anyone speaking utilize a voice amplification system.

Accessibility for performers and presenters is often frequently missed. As with asking 
attendees, asking performers and presented for their accessibility requirements is 
best practice.

Consider stage setup needs including whether or not a stage requires a ramp
A stage ramp should be no more than 5% grade and ideally feature handrails 
Include both cocktail and standard height tables
Provide a wireless microphone or one with an adjustable stand for people who 
need to sit or use mobility devices
Podiums or lecterns should be placed at least one metre away from the stage 
edge, to prevent accidents and falls for speakers who are blind or partially 
sighted, who may not be able to see the end of the stage

A height adjustable or universally designed lectern is highly 
recommended to provide access to people of all heights.

The edge of the stage should be high contrast to the surrounding areas 
providing additional visibility for people with low vision.

Stages
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Signage

Signage should be robust and include directional signage at decision points as well 
as maps with clear icons In key locations.

Use consistent icons and include the location of accessible services such as 
washrooms, accessible parking, sensory friendly spaces and viewing 
platforms.

Use a text size of at least 14 point font and sons serif fonts as they are easier to 
read particularly for those with literacy disabilities.
Use high contrast ideally seventy percent contrast between the background and 
the text or icons.
When using icons choose ones that are universally understood and obvious as to 
their intent.

Iconographic signage should be used for washrooms, parking, and the 
information booth, at minimum

Place signage at eye level for people seated in mobility devices, roughly 1200 mm 
from the floor.
Ensure that signage does not block sidewalks paths of travel or create tripping 
hazards.

Signage is extremely important to individuals with disabilities as correct signage 
allows people to determine the shortest path of travel from their location to the 
amenity they are seeking as well as reduce feelings of anxiety.

Technology
Technology can be an incredibly useful tool particularly for large event space 
navigation.

Consider implementing a navigational tool such as Blindsquare, a self-voicing GPS 
app that delivers information about location and points of interest at an large-scale 
event.
NaviLens is a wayfinding technology that empowers people who 
have low vision or are blind, as well as sighted users to navigate 
the environment with ease. The system uses  codes similar to QR-
codes that are placed strategically around the environment.  For 
blind users, the app announces the distance to the code as they 
pan their phone around the space.  It provides immediate spatial 
orientation, letting users know where the code is located and how 
far away it is.  It also provides information that is stored in the 
code such as the name of the location, information about the 
location and details of the surrounding area.
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Sensory Considerations
People with sensory based disabilities such as neurodiversities, dementia or sensory 
learning disabilities require some additional considerations for their full participation.

Informing attendees in advance of any sensory stimulation (strobe lights, flashes, 
loud sudden noises etc) is just as important as letting event attendees know of any 
accommodations that are available on site.   

Consider the lighting and sound levels within an environment.  Can the speaker or 
performers be heard across the entire venue?  Are there areas where someone can 
go to have a quiet conversation?  Is there significant glare, heat or differences in 
lighting levels

Sensory Friendly Spaces

Sensory friendly spaces are calm and quiet areas with activities and seating designed 
to be supportive for those with sensory sensitivities to recharge.  The spaces contain 
sensory toys (items such as stress balls, fidget toys) and other calm activities and 
seating that are designed to create a sense of calm when overstimulated, for 
whatever reason.
They are places where someone can retreat to if they are feeling overstimulated by 
the environment, allowing for a safe place where they can reintegrate their senses.
Sensory friendly spaces are highly recommended for large scale events.

Sensory Friendly Kits

Some event organizers provide loanable sensory-friendly kits , often available at 
information booths or the sensory friendly space to attendees with items included 
such as:

• Noise cancelling headphones
• Sunglasses
• Fidget toys or stress balls
• Basic picture symbols to be used as communication tools
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Service and Guide Animals
In British Columbia, guide and service dogs are recognized under the Guide Dog and 
Service Dog Act (GDSDA) which governs the certification of guide and service dogs 
as well as specifically certifies specific rights and protections under the BC human 
rights code.

Guide and service dogs are not pets.  They’re highly trained partners in mobility and 
accessibility for people who are blind, Deafblind, who have low vision, have a mobility 
disability or a health disability such as epilepsy.

Certified Guide and Service dogs have the same rights as individuals without dogs 
when accessing public services, places and events.  These animals are exceptionally 
well-trained ensuring that the dog is safe calm and stable in public settings.  It’s 
important to note that emotional support animals are not covered under this same 
act and do not have the same rights as guide or service dogs while they may be 
accommodated in certain situations it is up to the venue or event organizers to make 
that accommodation.

Seating Considerations:

Guide and service dogs are not to be approached touched or distracted while they 
are working.  This is identifiable by the dog wearing a harness and a vest indicating 
that they are a service dog.
Providing water and an area designated for pet relief it’s best practice at large 
outdoor events.
Guide and service dogs must be provided access (except to food and beverage 
preparation areas and pools) provided that the animal is well behaved.

PADs Service Dog, Alma
Credit:  https://pads.ca/

CNIBC Guide Dog
Credit:  https://www.cnib.ca/en/cnib-guide-dogs?region=on
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Physical Access
Parking and Transportation

 Is there accessible parking with clear signage? 

 Is it sufficient for the event or does temporary additional parking required?

 Is it close to an accessible entrance? 

 Is public transportation readily available and accessible? 

Entrances and Exits

 Is there step-free access to the venue? 

 Are there automatic doors or doors or doors that require minimal force to open? 

 Is the entrance wide enough for wheelchairs and mobility devices? 

Onsite Navigation

 If there is slope, is  it low-grade slope(5%) and or ramps with handrails? 

 Do stairs or steps have handrails?

 Are elevators working and accessible? 

 Are pathways wide enough for two people to pass each other?

 Can primary facilities be set up along primary paths of travel?

 Are there any overhead obstructions along the path of travel?

Washrooms

 Are there accessible, gender-neutral, and family restrooms available? 

 Are they clear of obstructions? (No items stored inside, for example)

 For large events, is there an adult-sized change table available, or one nearby?

 Is there a sufficient number of accessible washroom stalls or have additional ones been 
rented?

 Are washrooms located near primary event activities?

EVENT ACCESSIBILITY CHECKLIST

Accessibility Resource:  Accessible and Inclusive Language 

Seating Considerations:13 Accessible Events, Meetings and Presentations Guidelines



Seating and Tables

 Is there accessible a range of seating types offered?

 Does some seating include armrests and backrests?

 Are there standard height tables (in addition to cocktail height)?

 Do any tables have knee clearance?

 Are table cloths half length?

 Do any of the tables need to be marked as “accessible”?

 Has the placement of individuals with disabilities been considered when creating seating 
charts or event layouts?

 Is there an elevated viewing platform or does a person using a mobility device have a 
clear line of sight to the main attraction?

Food and Beverage

 Is there accessible water fountains or beverage station?
 Are food and beverage options clearly labelled?
 Are food and beverage options at a height that is accessible for someone seated?
 Is the point of sale for food and beverage options an accessible height and reach?
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Communication Access

 Have event attendees been informed of being able to make accessibility requests?

 Do event publications, invitations, websites etc. include information on accessibility or 
where to find out more about the accessibility of the event?

 Does the venue have a hearing loop or has a temporary one been considered?

 Do electronic communications include accessible best practices (alt text for images, 
large font etc.)

Signage

 Are signs clear, large, and in high contrast? 

 Is signage tactile or in Braille where appropriate? 

 Does a map indicate the location of primary amenities and accessible features?

 Has technology been considered?

Interpretation 

 Has an ASL interpreter been booked?

 Are closed captions enabled?

 Have speakers been reminded to use microphones and repeat questions from the 
audience?

Event Materials

 Can event materials be requested in alternative formats (e.g. Braille or electronic)?
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Sensory Access
 Is there a sensory friendly space or quiet area?
 Is a sensory -friendly kit available for loan?
 Are noise canceling headphones available for loan?

Lighting
 If indoors, is the lighting adjustable? Can it be dimmed or brightened as needed?
 Are there shades on the windows to reduce glare?

Acoustics
 Is there a public address system?
 Are assistive listening devices available?
 Are there measures to minimize background noise or a quiet area?
Smells

 Is the venue aired out to minimize strong smells, especially from cleaning supplies or 
construction materials?

 Does the venue have a scent-free policy?

Staff and Volunteer Training
 Are staff and volunteers trained in communicating with people with disabilities?
 Are there staff or volunteers available to assist people on site such as with scribing, 

Assisting with food or beverage service, providing general information et cetera?
 Are staff or volunteers at key event amenities such as at information, will-call or ticketing 

familiar with the onsite accessibility accommodations?
 Is a staff member or volunteer available to act as an escort for individuals who are blind 

or who have low vision?  (For performers with low vision or to assist guests in finding 
their seats).

 I’ve stopped and trained on interacting with a service or guide dog?
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Accessible and Inclusive Language
Language changes our perceptions and how we interact with each other. The "Golden 
Rule" applies to everyone, including people with disabilities. Remember, when in doubt; 
treat someone the way you wish to be treated and put the person first.  It’s easy!  Talk to 
the person, not the person they’re with. Look at the person, not the interpreter.  Make no 
assumptions about the person’s ability or disability.

The best place to start is with the person!

If you need to refer to the person, in relation to their disability, use person-first language 
and these words with dignity.

• Person with a disability
• Person who uses a wheelchair/walker/scooter/mobility device
• Wheelchair user, white cane user
• Person who is Deaf or hard of hearing
• Person who uses Sign Language
• Person who has a developmental disability
• Person who has an intellectual disability
• Person who has a mental illness/mental health injury
• Person who has bipolar disorder/schizophrenia/anxiety/ depression etc.
• Person who has low vision or is blind
• Person who has dwarfism
• Person who has a communication disability
• Person who has a stutter
• Person who has autism/autism spectrum disorder
• Person who has an amputation
• Person who has a prosthetic limb
• Person who has cerebral palsy/spina bifida/Down syndrome etc.
• Person who has a learning disability

Note:  Within the neurodiverse community in particularly, there are differences with how 
people relate to person-first language.  Best practice is to use person-first language unless 
otherwise indicated, otherwise use the term that is preferred by the individual.  Many 
members of the neurodiverse community prefer Autistic person over person with autism, 
for example.

VOLUNTEER TRAINING
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In General 
• Ask “How can I help?” 

o Allow the person to tell you how they would like to be helped 
o If they say “no”, listen 
o If you know of a piece of equipment that could help them, let them know of the 

availability 
• Let them know you are available if they need you 
• Focus on the ability not the disability 
• Avoid words like “inspirational” unless the person has done something inspirational. 

o For example, attending event is not necessarily inspirational but achieving a new 
personal best or trying something that scares them is 

• Avoid trying to relate to the person based on their disability 
o For example, when talking to someone who uses a wheelchair, don’t tell them 

how you used a wheelchair for a week when you broke your leg and know how 
hard it can be 

• Speak directly to the person, not the caregiver or interpreter. 
• Allow the person to speak for themselves. If they can’t communicate with you, the 

caregiver/attendant will let you know. 
o Never speak about them as though they are not there 

• Always assume a person can understand you, even if they are non-verbal 

Mobility Device Users 
• Always ask before you touch, push or move someone’s mobility device 
• Ask before pushing someone using a wheelchair o Wheelchairs are seen as an 

extension of someone’s personal bubble – don’t lean on them 
• Sit down and be at eye-level with the person if possible, don’t necessarily lean in, 

reducing their personal bubble 
• For many, a mobility device can be part of someone’s self-identity. Colour 

preference, style, equipment and lights are all custom features that reflect 
someone’s individuality 
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• Get the person’s attention via visual cue or a gentle touch on their arm 
• Speak clearly and normally – avoid over-enunciating words 
• Don’t shout or speak unnaturally slow, this makes lip-reading more difficult 
• Face the person and make eye contact 
• Find a quieter environment to communicate, if possible 
• Use gestures 
• Write messages 
• Minimize background sounds 
• Avoid chewing gum 

People who are Deaf or Hard-of-Hearing

• Introduce yourself and anyone else who is part of the interaction 
• When passing someone who is visually-impaired, let them know where you are and what 

side you are passing them on rather than trying to sneak past, this can be very 
disconcerting 

• Assume that they can see you – many individuals have some vision or partial vision 
• Never grab or touch someone without them knowing your intention 
• Ask if they would like to be guided and ask HOW they would like to be guided o People 

who are blind or have low-vision have different ways they like to be guided, some like to 
take the inside of your elbow, others prefer a hand on your shoulder 

•  Offer to provide a tour of the space and narrate for them where key features are such as 
the washrooms. 

• Provide clear verbal cues using directions such as “on your left” or “there is a set of 5 
stairs ahead of you.” 

People who are Blind or who have Low Vision

Deaf, spelled with a capital D is 
culturally significant as this 
indicates that a person is part of 
the Deaf culture.  Often, though 
not always, the person uses ASL 
and feels connected to their Deaf 
identity.

Did you know?
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People who Have a Communication Disability
• Be face to face and make eye contact 
• Watch for understanding 
• Say one thing and stop. Give the listener a chance to respond 
• Offer a choice of two options (or limited options) 
• Keep your language simple 
• Don’t ask questions you already know the answer to 
• Speak age-appropriately, don’t use baby talk, especially with an adult or youth 
• Use gestures, pictures, written words to help the person understand 
• Stick to one conversation topic at a time 
• If someone can’t think of the word, ask them to describe it 
• Ask for clarification when you don’t understand 
• Listen and wait. If someone has a stutter or difficulty expressing themselves, don’t 

interrupt, just give them time 
• If someone is using a communication board or device, remain face to face rather than 

looking at the board 
• If someone has speech that is challenging to understand, repeat back what you’ve 

heard for confirmation 
• Be patient 
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This one is a bit tricky and it depends on context. Expression such as “Let’s go for a walk,” 
“It’s nice to see you,” “I haven’t heard from you in a while,” “Did you see that?” are fine and 
those with a disability will unlikely take offence.

Someone who uses a wheelchair may say that they are going for a walk or choose to say 
that they are going for a wheel but don’t feel uncomfortable if you are walking or inviting 
them for a walk.

“Are you blind?” “What are you deaf?” “That’s so retarded.” Are examples of offensive 
language that should be avoided.

Expressions and Terms to Avoid
Some people and organizations advocate for the use of “diverse abilities” as a euphemism 
intended to highlight the person’s abilities rather than disabilities.  Disability is not a 
shameful word and many with disabilities do not identify with the term ‘diverse ability.’  
This particular term is used almost exclusive by those in Community Living and generally is 
understood to refer to someone with cognitive and mobility disabilities. For that reason, it 
is not encouraged to use this term in general use to mean someone with a disability.

Other expressions to avoid include:
• Anything that labels a person in an unflattering way. For example, “She’s insane” or 

“He’s a schizo”
• Using the word “challenged” or “handicapped”
• “Special needs” is also not a preferred term outside of the school system and generally 

not preferred by people with disabilities
• Try to avoid using mental health and mental illness related words that increase stigma 

such as “happy pills,” “psycho” or “lunatic”
• Words that restrict ability such as “wheelchair-bound,” “suffering from,” “affected with” 

or “victim”

What About Expressions?
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ACCESSIBLE AND INCLUSIVE VOCABULARY
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ACCESSIBLE MEETINGS & PRESENTATIONS

Planning

Ask all participants what accommodations they may need to fully participate 
in the meeting or presentation.
Enable captioning for the meeting, including break out rooms.
Hire an ASL interpreter, if requested. 
Provide materials, in advance to the ASL interpreter.
Plan to wear a colour that contrasts with your skin-tone, lighting can wash out 
people’s faces, making lip reading difficult.
Provide attendees information on how to access the meeting, including 
alternative means such as keyboard shortcuts and voice commands if virtual 
and the location of accessible washrooms and other facilities for in-person 
meetings.
If meeting in-person, a u-shape configuration is most accessible for people 
who are Deaf and those relying on lip-reading.
When meeting in-person, provide all pertinent information on parking, 
wayfinding when entering the site, signing in protocols etc. to guests.
Provide an email and phone number for anyone experiencing accessibility or 
connection issues for hybrid or digital-based presentations.
For engagement sessions consider providing note takers or scribes to help 
people communicate written information.
Ensure that signage is clear directing people to the meeting room.
Consider providing an area that is quiet allowing people to take a break from 
the meeting or presentation or allowing people the opportunity to 
communicate more comfortably especially when someone is hard of hearing.
Consider providing materials in advance in digital large print or Braille 
formats if requested.
Communicate accessibility requirements to presenters and ensure that 
presentation materials are accessible.
Ensure stage or speaking area is accessible. If using a podium, confirm it is 
height-adjustable or there is space to present without it.
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Preparing A Presentation

Limit the text on each slide.
Use bullet points and spacing to avoid clutter and long paragraphs.

Choose a font that is sufficiently large (24 point) and sans serif. 
Avoid excessive use of italics and underlines.
If linking to webpages, ensure the text is a large font.
Be thoughtful in your use of motion and animations. Avoid sensory overload. Be 
mindful of flashing content, loud or abrupt sounds, or visually busy slides.
Use high contrast colours for text.  For example white text on a dark background or 
dark text on a light background.
Run an Accessibility Check on your presentation (found under “review” in 
PowerPoint.
Include ALT-Text for any visuals, particularly if the presentation will be shared with 
attendees.
Make multi-media fully accessible: turn on closed captions, provide transcripts of 
videos and give visual descriptions of pertinent visual content.
Avoid using tables.
Don't rely on colour alone, U shapes labels and patterns to help convey 
information.
Use consistent visual cues. Predictable design elements (e.g., heading styles) help 
with cognitive processing.
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Ensure that both the presenter and the ASL interpreter are pinned/spotlighted.
Enable closed captioning, and provide instructions to attendees To ensure they are 
aware of the ability to turn on closed captions should they need it.
Make sure we can see and hear you! Good lighting, microphone and bandwidth are 
key.
Utilize both the chat and hands up feature for questions .
Verbally repeat questions asked in the chat.
Enable the “Mute Participants Upon Entry” feature.
Limit the use of the Zoom Polling Feature as this feature has some accessibility 
barriers.
Describe what you are annotating if you are using the whiteboard feature.
Make eye contact with your camera. 
Record your presentation for later distribution.

Speak clearly, using simple language and at a moderate pace.
Avoid the use of technical jargon and acronyms
Give people time to process the information. Pause regularly.
Ensure that you are visible. Use good lighting and, if presenting digitally, be 
centered on camera.
Describe all relevant visual information including graphs, charts and pictures. 
Use a microphone. Even if you have a ‘voice that caries.’
Limit distractions.
Pause to give the audience a moment to read what is on the slide.
Repeat questions from the audience, especially if a microphone has not been 
provided to audience members.
Avoid pointing without context. Describe what you’re referencing instead of just 
gesturing.

Presenting Best Practices

Presenting Digitally
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Ensure that both the presenter and the ASL interpreter are pinned/spotlighted.
Enable closed captioning, and provide instructions to attendees to enable the 
captions themselves.
Make sure we can see and hear you! Good lighting, microphone and bandwidth are 
key.
Utilize both the chat and hands up feature for questions.
Verbally repeat questions asked in the chat.
Enable the “Mute Participants Upon Entry” feature.
Limit the use of the Zoom Polling Feature as this feature has some signifant 
accessibility barriers.
Describe what you are annotating if you are using the whiteboard feature.
Make regular eye contact with your camera. 
Record the meeting and transcription for later distribution.
If possible, enable the AI assistants for note-taking and live transcription.

Meeting Digitally

Zoom Best Practices

Review https://explore.zoom.us/en/accessibility/
Zoom features include: dark mode, focus mode, auto-generated captions, manual 
captions, multi-spotlight, multi-pinning, re-arrange gallery view, record meetings
Under Settings, Accessibility Settings, users can:

Customize the font size of the chat and captions
Explore keyboard shortcuts
Get screen reader support

Microsoft Teams Best Practices

Review https://support.microsoft.com/en-us/office/accessibility-tools-for-
microsoft-teams-2d4009e7-1300-4766-87e8-7a217496c3d5
MS Teams features include: sign language view, transcriptions, auto-generated 
captions, record meetings, using headings in the chat, add alt-text to images in the 
chat, 
Team’s polling feature is accessible for screen readers.
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WHY DO ICONS MATTER?

Iconography
Icons are important for accessibility because they provide visual cues that can be 
quickly and easily understood by a wide range of users, regardless of their language 
skills, cognitive abilities, or sensory impairments. 
Universal understanding: Well-designed icons transcend language barriers and can 
be interpreted by people from diverse backgrounds including folks who don’t speak 
English as a first language. 

Cognitive accessibility: Icons can help people with cognitive disabilities or learning 
difficulties to better understand and navigate their environment. Simple, clear icons 
reduce the cognitive load required to process information.
Wayfinding assistance: Consistent use of standardized icons throughout a building 
or site can aid in wayfinding, especially for individuals with intellectual disabilities or 
those who are unfamiliar with the space.

Benefit for people with low vision: When designed with high contrast and sufficient 
size, icons can be more easily perceived by people with low vision compared to text 
alone.

Supports non-readers: Icons can convey important information to individuals who 
have difficulty reading, whether due to a visual impairment, learning disability, or 
language barrier.

Key Considerations
• Use internationally recognized symbols, like the International Symbol of Access.
• Ensure adequate size and contrast for visibility.
• Place icons on signage that is mounted at an accessible height and providing 

clear floor space for approach.
• Utilize tactile icons with braille labels on signage to support users who are blind 

or have low vision.
• Maintain consistency in the design and use of icons throughout a site.
• Incorporate well-designed, universally understood icons to create 

environments that are more intuitive, easier to navigate, and accessible to a 
broader range of people.
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WHY IS CONTRAST SO IMPORTANT?

Contrast to support people with Low Vision
• Contrast makes things easier to identify and distinguish. High contrast between 

an object and its background helps those with low vision better perceive 
shapes, edges, and boundaries.

• It improves legibility and readability. When there is strong contrast between 
text and its background, it is easier for people who have low vision to read and 
interpret letters, words, and symbols.

• Contrast provides visual orientation. Things like doorways, handrails, and 
signage stand out better when there is significant contrast with surroundings. 
This aids navigation and independence.

• Reduced contrast contributes to eye strain and fatigue. Insufficient contrast 
makes visual tasks more difficult and tiring for those with low vision.

Contrast for Balance
• Contrast highlights edges and boundaries. When moving from seated to 

upright, high contrast along the edges of steps, floors, and thresholds makes 
these changes in level clearly visible. This prepares the body for adjustments.

• It defines spatial orientation. Contrast provides visual cues that help the brain 
orient itself in space, allowing for better balance control such as knowing where 
a wall, handrail or counter is helps stabilize our vision.

• Distinct edges guide movement. Clear definition where surfaces change, 
facilitated by contrast, guides body motions like getting up from a chair or 
exiting a vehicle.

• It draws attention to tripping hazards. Significant contrast makes irregularities 
in floors, pavements, ramps readily apparent so they can be navigated safely.

• Low contrast obscures surroundings. With inadequate contrast, visual 
environment blends together, depriving brain of key reference points needed 
to maintain equilibrium.
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Introduction 
Social media is a powerful tool for communication, engagement, and commu-

nity building—but when content isn’t designed with accessibility in mind, it 

can exclude people with disabilities. This guide offers practical tips to help 

ensure your posts reach everyone in the District of Saanich’s community, in-

cluding those who are blind, have low vision, are deaf or hard of hearing, have 

cognitive or learning disabilities, or use assistive technologies. 

Why Social Media Accessibility Matters 
Accessible social media benefits everyone. When content is perceivable, op-

erable and understandable, it reaches a wider audience and demonstrates a 

commitment to inclusion. Many people rely on screen readers, captions, tran-

scripts or other assistive technologies. Without accessible posts, they miss 

important information and opportunities to participate. Making content ac-

cessible is also a legal obligation under human rights legislation. By prioritiz-

ing accessibility, the District of Saanich fosters a culture of respect and en-

sures compliance with relevant guidelines. 

General Best Practices 

Inclusive and Clear Language 

• Write in plain language: Use short sentences, everyday vocabulary, 

and avoid jargon or acronyms unless you spell them out on first use. 

Clear communication supports everyone - including people with 
cognitive disabilities and those using translation tools. Please see ‘Plain 

Language and Overall Access’ in the Resources section of this guide for 

additional tips on best practices on plain language use. 
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• Use inclusive language that respects the diversity of your 
audience: People-first (such as, “person with a disability”) or 

identity-first (such as, “disabled person”) language may be appropriate 
depending on individual preferences; avoid ableist or gendered terms. 
For example, avoid expressions like “blind to the issues” or “turn a deaf 

ear.” 

• Maintain a friendly but professional tone: Use active voice and be 

mindful of readability. 

Alt Text and Image Descriptions 

• Provide alternative (alt) text for all images, graphics and GIFs: Alt 

text conveys the essential information conveyed visually. 

• Keep alt text concise but descriptive. Mention key details, context 
and identities relevant to the content: Avoid phrases like “image of” 

because assistive technologies already announce the media type. 

• Be thoughtful about identity: Include aspects of someone’s identity 

(like gender expression, disability, or cultural background) in alt text 

when it’s contextually relevant to the image’s purpose or message. Avoid 
using labels unnecessarily, but don’t omit important context that helps 
users fully understand the image. 

• For complex visuals, include a longer description in the post or 
link to a text description elsewhere: Alt text should supplement—not 
replace—image descriptions when more detail is needed. 

Example: A photo of a community garden could have alt text: “Raised 
vegetable beds with sunflowers and children planting seedlings alongside 

adults of varying ages.” 

 

Captions, Transcripts and Audio Descriptions  

Understanding Captions, Transcripts, and Audio Descriptions 
Before diving into best practices, it’s helpful to understand the differences 
between the key tools used to make videos accessible. 
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Definitions: 
 
Captions 
Captions are synchronized text that displays spoken dialogue and relevant sounds, like 
music or sound effects. They support people who are Deaf, hard of hearing, or who prefer to 
watch videos without sound. 

 
Transcripts 
Transcripts are a full written version of a video’s content, including spoken words and, 
where applicable, descriptions of important sounds or visuals. They can be read separately 
from the video and are useful for searchability and quick reference. 
 
Audio Descriptions (AD) 
Audio descriptions are additional narration tracks that describe key visual elements—like 
scene changes, facial expressions, or on-screen text—for people who are blind or have low 
vision. They're especially useful when visuals are essential to understanding the content. 
 

• Caption all videos: Use closed captions when possible so users can 

turn them on or off. Edit auto-generated captions for accuracy. 

• Provide transcripts for audio and video content: Transcripts help 

users who cannot view video or who prefer reading. 

• Ensure captions and subtitles have adequate contrast: Especially 

with the background and are synchronized with the audio. 

Hashtags and Emojis 

• Use CamelCase in multi-word hashtags: (such as, 

#AccessibleSaanich) so screen readers can pronounce each word. Put 

hashtags at the end of your post and limit the number you use. 

• Avoid special characters, stylized fonts or unicode characters: 

These cannot easily be interpreted by screen readers 

• Use emojis sparingly: If you include emojis, place them at the end of 

the post and separate them by spaces so screen readers articulate each 
one. Do not use emojis to replace words. 
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Colour Contrast and Visual Design 

• Ensure sufficient colour contrast between text and background: 
The Web Content Accessibility Guidelines (WCAG) recommend a 

contrast ratio of at least 4.5:1 for normal text and 3:1 for large text. 

• Do not convey meaning by colour alone: When presenting data, use 

patterns, labels or textures in addition to colour. 

• Avoid flashing or strobing content that may trigger seizures: If you 

must include a flashing effect, provide a clear warning and limit the 
frequency to under three flashes per second. 

• Ensure that overlay text on images or videos remains legible: 

Particularly against the background by adding a semi-transparent colour 
block or drop shadow. 

Links and Formatting 

• Use descriptive link text instead of generic phrases like “click here.” 
Describe where the link will take the user. 

• Avoid posting long URLs in the main text. Consider using a short, 

descriptive link or link shortener that preserves context. 

• Use built-in heading styles instead of manually bolding or 
changing fonts. This helps assistive technology identify the document 

structure. 

• Left-align text for easier readability and avoid fully justified text, 
which can create uneven spacing. 

• Avoid using all capital letters (ALL CAPS) for extended text, as 

screen readers may interpret them as acronyms and reading 
comprehension is reduced. 

Sensory Considerations 

• Provide content warnings for sensitive material such as flashing lights, 

violence or traumatic events so users can choose whether to engage. 

• Avoid auto-playing audio or video. Allow users to control playback. 
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• Consider multiple modalities. Whenever possible, offer information in 

more than one format (visual, auditory and written) so users can access 

content in the way that best suits them. 

 

Platform-Specific Guidelines 
The following sections provide platform-specific recommendations for acces-

sible social media content. While the general best practices apply to all plat-

forms, certain features and processes differ across platforms. Use the guide-

lines below when creating content for each platform. 

Facebook 

• Add custom alternative text to all photos by selecting "Edit Alt Text" 

when uploading images. Review Facebook's automatic alt text and 
override it if inaccurate, to do this: 

o Go to Create Post and upload your photo. 

o After the image loads, click the Edit button on the image preview. 

 

 



 
 

7 
 
 

o In the pop-up window, select Alt Text in the left panel.

 

o Click Override generated alt text, then enter your custom 
description. 

 

o Click Save, then finish your post 
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• Caption all videos. Upload a caption file (such as, .srt) for recorded 

videos and use live captioning tools or third-party services for Facebook 

Live. Ensure captions are accurate and synchronized. 

• Describe complex images or charts in the post body or a separate 

image description. Provide context so screen-reader users receive the 
same information. For example, if describing the following chart: 

 


������ Image Description (Alt Text for Screen Readers): 
A vertical bar chart titled "Number of Files Uploaded by Month." It shows the number of 
videos, documents, and images uploaded in January, February, March, and April. 

• January: 112 videos, 716 documents, 2,591 images 
• February: 96 videos, 518 documents, 1,547 images 
• March: 74 videos, 207 documents, 1,236 images 
• April: 158 videos, 900 documents, 1,934 images 

Images consistently had the highest uploads across all months, peaking in January. Docu-
ments followed, with a steady rise in April. Videos had the lowest upload counts in all 
months. 

• Use CamelCase for hashtags and limit them to no more than a few per 

post. Place hashtags and @mentions at the end of the caption. 
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• Avoid relying on reaction slides or memes without description. If 

using screenshots of text, provide the text in the post body. 

 

Instagram 

• Add alt text to images using the "Accessibility" or "Advanced Settings" 

field when creating or editing a post. Provide concise descriptions of 

what is important in the image. To do this: 

o Tap the + icon to create a new post and select your image. 

o After applying filters and editing, tap Next. 

o Tap More Options at the bottom of the screen. 

 

o Under Accessibility, tap Write alt text. 
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o Enter your custom alt text and tap Done.

 

For existing posts: 

o Go to the post and tap the three dots (…). 

 

o Tap Edit, then tap Edit Alt Text in the bottom-right corner of the 
image. 

 

 

o Add or revise the alt text, then tap Done. 

• For Stories and Reels, add open captions or use caption stickers. 

Edit Instagram's automatic captions to correct mistakes and ensure 
readability; position captions away from overlaying important visuals. 
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• Ensure text overlays, stickers and polls have sufficient colour 
contrast with the background. Avoid placing text over busy images; 

use solid backgrounds or high-contrast colours. 

• Use CamelCase hashtags and limit to a few relevant tags. Place 

hashtags and @mentions after the main caption, separated by a line 
break. 

• Do not rely on images of text alone. Include key information in the 

caption so that screen-reader users and translation tools can access it. 

LinkedIn 

• Add alt text to images when sharing posts or articles. LinkedIn 

allows you to enter a description when uploading an image; provide 
concise descriptions that convey key information. To do this: 

o Start a new post and click the image icon where is says 
"Photo". 

 

o Upload your image, then click the alt button on the image 

preview. 

 

o Enter your description (up to 300 characters), then click Save. 

• Upload caption files (such as, .srt or. vtt) when posting videos. Do 
not rely solely on auto-captions, and avoid uploading videos without 
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captions. You could also choose to embed the captions right in the 

video when exporting it. This ensures it can't be toggled on or off. 

• Avoid stylized or special unicode fonts in your headlines, names or 
posts. Screen readers often mispronounce these characters or skip 

them altogether. 

• Write clear and concise text. Break longer posts into short paragraphs 

and use lists or headings for structure. Use descriptive link text rather 

than "click here." 

• Use CamelCase hashtags sparingly. Place hashtags and mentions at 

the end of your update rather than interspersed within the sentence. 

X (Twitter) 

• Add alt text to all images and GIFs when posting. Twitter supports 

up to 1,000 characters of alt text—describe the visual content clearly 
and concisely. To do this on a mobile device: 

o Start a new post and upload an image.

 

o Tap or click +ALT in the bottom right corner of the image.

 

o Enter your alt text (up to 1000 characters), then tap Save. 
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• Provide captions for videos by using Twitter's Media Studio to 
upload caption files or by burning captions into the video before 
uploading. Do not share videos without captions. 

• Use CamelCase hashtags and limit yourself to two or three 
relevant tags. Place hashtags and @mentions at the end of your tweet 
to improve readability.  

Note on Hashtags: While hashtags are still useful for reinforcing branding and 

organizing content (especially in live events or campaigns), their influence on 
discoverability has decreased across several platforms. X, for example, now limits 

hashtags in paid promotions to streamline content and reduce distractions. 

Consider using branded or thematic hashtags sparingly and always in CamelCase 
for screen reader clarity. Avoid over-relying on hashtags for reach, and focus on 

clarity and engagement in the core message itself. 

• Avoid using special fonts or unicode characters. They are 

inaccessible to screen readers and may be misinterpreted by assistive 

technology. 

• Use plain language and keep tweets concise. If sharing a thread, 

number each tweet and use the same alt text conventions. 

• Limit the use of emoji. When used, place them at the end of the tweet 

and do not overuse consecutive emoji, which can cause repeated 
screen-reader announcements. 

YouTube 

• Provide accurate, synchronized captions for all videos. Upload a 

caption file (such as, .srt or. vtt) or edit YouTube's auto-generated 
captions. Ensure proper punctuation and speaker identification. To do 
this on a computer: 

o Go to YouTube Studio (https://studio.youtube.com/). 

o Click Content, then select the video. 

https://studio.youtube.com/
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o In the left menu, click Subtitles. 

 

o Choose your language and click Add > Upload file > With timing 

or Without timing, then select your caption file (.srt, .sbv, etc.). 

o Alternatively, use the Auto-sync option by pasting your transcript 

and letting YouTube generate the timing. 

• Include a transcript of the video's spoken content in the 
description or a linked document. Transcripts support users who 
prefer to read rather than watch or listen. 

• Write descriptive titles and descriptions that summarize the video 
content. Include keywords and any content warnings (such as, flashing 
lights or sensitive topics). 

• Use high-contrast thumbnails with minimal text and strong 
visuals. While YouTube does not support alt text for thumbnails, you can 
describe the thumbnail in the video description. 

• Provide audio descriptions for key visual information that is not 
conveyed through dialogue. You can include audio description in the 
main video or create a separate described version. 

• Avoid auto playing videos on websites and embed players. Provide 

clear controls for play/pause, volume and captions, and ensure they are 
keyboard accessible. 
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Tools and Accessibility Check 

• WebAIM Colour Contrast Checker – This tool can test colour 

combinations for sufficient contrast. Use it when designing infographics 

or overlaying text on images. 

• Accessible hashtag generators - These tools help convert hashtags to 

CamelCase automatically. This generator by Hootsuite is pretty nifty! 

• Captioning tools – platforms like YouTube Studio, Kapwing, Descript or 

Adobe Express can generate and edit captions. Always review 
auto-generated captions for accuracy. 

• Screen reader testing – use free screen readers such as NVDA 

(Windows) or VoiceOver (iOS/Mac) to experience your content as a blind 
user might. 

• Accessibility checkers built into social platforms – use Facebook’s 
alt-text editor, Instagram’s accessibility settings and LinkedIn’s alt text 

field to add descriptions. 

• Plain language tools – readability checkers like Hemingway or 
Grammarly help simplify language and avoid jargon. 

Resources 

Plain Language and Overall Access 

• Government of BC. Plain Language Checklist 

• Plain Language.gov 

• Center for Plain Language. Five Steps to Plain Language 

• Harvard University Digital Accessibility Team. "Social Media 

Accessibility Best Practices" 

• Disability:IN. "Creating Accessible Social Media Content"  

• Sprout Social. 10 guidelines to make social media posts more 

accessible 

https://webaim.org/resources/contrastchecker/
https://www.hootsuite.com/social-media-tools/instagram-hashtag-generator
https://www.kapwing.com/
https://www.descript.com/
https://www.adobe.com/express/
https://hemingwayapp.com/
https://www.grammarly.com/
https://www2.gov.bc.ca/gov/content/governments/services-for-government/service-experience-digital-delivery/web-content-development-guides/web-style-guide/writing-guide/plain-language
https://www.plainlanguage.gov/
https://centerforplainlanguage.org/learning-training/five-steps-plain-language/
https://www.harvard.edu/in-focus/the-accessible-world/social-media-accessibility-best-practices/
https://www.harvard.edu/in-focus/the-accessible-world/social-media-accessibility-best-practices/
https://disabilityin.org/resource/24-hours-of-gaad-accessible-social-media-best-practices/
https://sproutsocial.com/insights/social-media-accessibility/
https://sproutsocial.com/insights/social-media-accessibility/
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• Sprout Social. "Inclusive Language Guide for Social Media" 

• W3C Web Accessibility Initiative (WAI) 

 

Alt Text 

• Medium. The case for describing race in alternative text attributes by 

Tolu Adegbite 

• Make Things Accessible. Alternative text: race, gender, and physical 

descriptions 

• Tink. Thoughts on skin tone and text descriptions - Léonie Watson 

 

Captions, Subtitles and Transcriptions 

 
• W3C - Making Audio and Video Media Accessible 

• W3C - Transcript Formatting Guidelines (writing clean, accessible 

transcripts) 

• W3C - Transcribing Audio to Text (tools and tips for generating 

transcripts) 

• W3C - Resource on Captions/Subtitles 

• WebAIM. Captions, Transcripts, and Audio Descriptions 

• DCMP.org. Described and Captioned Media Program 

• BBC. Subtitle guidelines 

 
 

 

 

https://seeds.sproutsocial.com/writing/inclusive-language/
https://www.w3.org/WAI/
https://medium.com/shopify-ux/the-case-for-describing-race-in-alternative-text-attributes-a093380634f2
https://medium.com/shopify-ux/the-case-for-describing-race-in-alternative-text-attributes-a093380634f2
https://www.makethingsaccessible.com/guides/alternative-text-race-gender-and-physical-descriptions/
https://www.makethingsaccessible.com/guides/alternative-text-race-gender-and-physical-descriptions/
https://tink.uk/thoughts-on-skin-tone-and-text-descriptions/
https://www.w3.org/WAI/media/av/
https://www.w3.org/WAI/media/av/transcripts/
https://www.w3.org/WAI/media/av/transcripts/
https://www.w3.org/WAI/media/av/transcribing/
https://www.w3.org/WAI/media/av/transcribing/
https://www.w3.org/WAI/media/av/captions/
https://webaim.org/techniques/captions/
https://dcmp.org/learn/captioningkey
https://www.bbc.co.uk/accessibility/forproducts/guides/subtitles/#Subtitle-Guidelines


Accessible Social Media 
Checklist 
 

This checklist summarizes best practices for creating accessible 
social media content across platforms. Use this as a quick reference 

before posting to ensure your content is inclusive for all users. Feel 
free to use this checklist as you are creating new posts on social 
media and ensure that each of the best practices has been followed 

for the platform you are posting on. 

 

General Accessibility Guidelines 

Category Guidelines 
Alternative Text 
(Alt Text) 

Always add accurate and concise alt text for 
images. 

Video Captions Include open or closed captions on all 
videos. You could also choose to embed the 
captions right in the video when exporting it. 
This ensures it can't be toggled on or off. 

Plain Language Use clear, simple language and avoid jargon. 
Emoji Use Limit emoji use and place them at the end of 

posts. 
CamelCase 
Hashtags 

Capitalize the first letter of each word in 
hashtags. 

Colour Contrast Ensure sufficient contrast between text and 
background. 

Animated Content Avoid flashing content; limit animation to 
under 3 flashes per second. 

 



2.    Accessible Social Media Checklist 

Facebook 

Category Best Practice 
Alternative Text Click on the image > Edit Alt Text > Enter 

custom description. 
Video Captions Upload SRT file or use Facebook’s automatic 

caption tool. 
Emoji & Hashtags Use sparingly; place emojis at end and 

hashtags in CamelCase. 

 

Instagram 

Category Best Practice 
Alternative Text Before posting > Advanced Settings > Write 

Alt Text. 
Video Captions Use external caption tools or reels editor to 

add text overlays. 
Hashtags CamelCase and avoid hashtag overload. 

Place after main post content. 

 

LinkedIn 

Category Best Practice 
Alternative Text Click the image > Alt Text > Add a clear 

description. 
Video Captions Upload SRT files or include text overlays in 

the video. 
Post Formatting Use bullet points and line breaks to improve 

readability. 

 

  



3.    Accessible Social Media Checklist 

X (formerly Twitter) 

Category Best Practice 
Alternative Text Click the image > Add description > Write 

alt text. 
Video Captions Upload videos with open captions or add 

text overlays. 
Hashtags Limit to 1–2 per post; remember paid posts 

or boosted posts will not be promoted if 
hashtags are used (circa June 2025) use 
CamelCase. 

 

YouTube 

Category Best Practice 
Captions Upload a caption file (SRT) or enable auto-

captions and edit for accuracy. 
Alt Text Equivalent Use the video description to summarize 

visual content. 
Thumbnails Ensure thumbnails have high contrast and no 

text-only images. 
  



4.    Accessible Social Media Checklist 

Testing Your Social Media Content 
for Accessibility 
 

Before publishing your content, consider the following checks to 
improve accessibility: 

• Use platform-specific accessibility checkers when available 

(e.g., Facebook and LinkedIn settings). 

• Use color contrast checker tools to ensure visibility. 

• Have someone else review the post with a screen reader. 

• Review how your post appears with captions enabled. 

• Double-check hashtags, emojis, and formatting for readability. 
 

https://webaim.org/resources/contrastchecker/


 

ADEI Advisory Committee Action List(reviewed and updated at September 3, 2025 committee meeting)

Questions to Consider &
Proposed Actions# Actions/Themes Description Priority

1 Youth Engagement Explore ways of involving young people in District affairs. Q: Should we be focusing on additional groups
(young adults, etc.)

Medium

Saanich has spots earmarked for youth reps on each of their advisory committees
however these often go unfilled. Q: Does Saanich have a Youth Engagement

Strategy?
Ways we can increase youth engagement include:

Committee Recruitment – Explore how Saanich currently reaches out to schools, colleges,
universities and other youth groups to recruit young people to serve on committees and
explore ways of doing more engagement.

Youth Rep – Some municipalities have a designated youth rep on Council.

Youth Advisory Committee – The City of Victoria has a Youth Council, this could serve as
a lower barrier way to engage with a number of young people who can provide input to
Council on a wide range of issues.

Course Credit – Work with UVic and other regional post-secondary institutions to arrange
for course credit or something similar for students who join and participate in Saanich
advisory committees.

2 Youth Strategy

3 Family Doctors

A mirror of the Older Adult Strategy, but focused on Youth. Q: Should CC call on staff, through Council, to
develop a youth strategy?

Medium

LowExplore ways for Saanich to encourage, incent and facilitate more family doctors within the No CC action required at this time. Councillor
municipality, and support existing doctors and medical professionals to help their practices Phelps Bondaroff has a citizens group (external)
flourish and serve as many Saanich residents as possible. working on this initiative.

Discussion should begin with an exploration of what type of direction does the CC want to
give Council. We can make a broad recommendation, like requesting that Council direct
staff to investigate and report back on measures the District can adopt to increase the
number of family doctors in the community, or we could request that Council direct staff to
explore specific measures, such as:

Granting Permissive Tax Exemptions for Doctors Offices and Clinics.

Use Community Amenity Contributions (CACs) to incent developers to build more clinic
spaces in mixed use developments.

Surveying existing Saanich properties to identify any that could serve as a clinic.

Building/converting one or more properties into clinics, using a similar model adopted by
Colwood.

4 Preventative Health Support Explore ways the District can support preventative health. Staff to ask the Parks and Recreation Department Medium
to make a presentation to the CC on programs
related to preventative health including: progam
design/development,
delivery, communications, evaluation and
responsiveness.

5 Speaker: Chief Accessibility
Officer

To brief the committee on the ongoing work being done in the country and the work of
translating federal legislation to the municipal level.

Councillor Phelps Bondaroff to table this at future
CC meeting. Rishi to reach out and connect with
Angela/Committee

Low



 

6 External-facing initiatives
within Community Services
Division

To facilitate understanding of external-facing initiatives within Community Services Division Staff to ask Community Services Division to make Low
a presentaion to the CC.

7 Flag and Recognition Policy Review Saanich’s flag and recognition policies. Staff to speak with Communications and
Legislative Services about current protocols and
return to CC.

Low

Low8 Reproductive Justice

9 Menstrual Equity

Providing condoms in Saanich rec centres. Q: should the District provide free condoms at
recreation centres?

Councillor Phelps Bondaroff to discuss current
practice with Recreation Senior Manager.

Explore opportunities to enhance Saanich’s free menstrual product policy. Q: Should Saanich provide reusable products at
key rec facilities (menstrual cups and cloth pads)?

Low

Councillor Phelps Bondaroff to discuss current
practice with Recreation Senior Manager.

10 Accessibility and Active
Transportation

How is Accessibility applied/incorporated within the District's Active Transportiation Plan? Review the existing accessibility measure’s within Medium
the District’s Active Transportation Plan including
trails and roads, sidewalks.

Engineering presented on this topic in March 2024.

Invite Engineering to return and proivde an update
in 2026.

11 Scooters and Mobilty Devices The District is participating in a regional pilot exploring kick scooters in bike lanes. This pilot Conduct a mid-way check in as data becomes Low
in Bike Lanes - Pilot Update runs to April 2028. available (anticipated 2028).

12 Festival Review Saanich leads and/or participates in a number of local festivals and events. Review how
ADEI is being incorporated.

Q: What festivals are happening in the Summer
and what is being done to support ADEI?

Medium

Staff to invite Sara Faria from PRCS to a CC
meeting in the Fall 2025.

13 Sensory-specific
programming and facilities

Ensure that Saanich programs and facilities support those with different sensory needs. Q: How are wayfinding, advertising and purchasing Medium
for/within exisitng facilities informed by sensory
programming needs?

Community Services (Loryn Anderson) presented
on this topic to the CC in November 2024.

Staff to invite Loryn and Santael to a future meeting
to provide an update on sensory art and swim

14 Mailing address support for
the unhoused.

Those experiencing homelessness often struggle to maintain a fixed address. Some
municipalities have helped to address this situation by creating free or low-cost postal
boxes for those in need.

Q: Should Saanich offer free or low-cost postal
boxes for those in need?

High

This was discussed with the CC in May 2024 as
part of the Cold Weather Protocol discussion.

CC to hear a presenation from a member on June
4, 2025.



 

15 Invisible Disabilties Explore the ways in which the District is helping support people with invisible disabilities Q: Should Saanich provide sunflower lanyards, and High
and investigate ways these measures can be improved. (Sunflower lanyards, wayfinding, how can we improve wayfinding and support
websites) information?

Councillor Phelps Bondaroff to conduct research
and discuss idea with Community Services Senior
Manager in July.

16 Accessibility and Town Halls Saanich is offering Town Hall meetings as part of its broader public engagement plan. Explore the existing practices around town halls
from an accessibility lens including factors such as
sound, temperature, space and seating.

Low

Staff to request current protocols from
Communications and Legislative Serivces and then
return to CC at a future date (early 2026).

17 Accessibility Guidelines Review of accessibility guidelines for meetings and events (virtual, in-person, indoor,
outdoor); documents (word, pdt, ppt, etc.); and social media usage.

Guildines are underdevelopment and will be
presented to the CC in September by Staff.

Medium

Medium

October Meeting

18 Different Cognitive and
Physical Abilities

Exploring ways of ensuring folks with diverse cognitive and physical abilities are
represented, heard, and included with a specific focus on youth programming and
facilities.

Q: What measures are being adopted to reduce
barriers for people with complex needs at our
recreation centres? What are we currently doing?
What can we do better?

- Staff to invite Recreation Division to present at a
future CC in late 2025. - Laurie-Anne K

19 Scent Free Policies at
Saanich Facilities

Some people are adversely affected by fragances. Today, many workplaces are adopting Q: What policies and education does Saanich High November Meetin
a scent-free environment policy. currently have? Are they adequate?

Staff to invite Occupational Health & Safety and
Recreation Divisions to present current practice to
CC in Fall 25 or Winter 26.

20 Parking Policy Ensure Saanich’s parking bylaw review supports accessibility. Staff will bring forward for the CC review and input Low
when required. Ask Bylaw about what consultation
is taking place - accessible?

21 Hiring a Social Planner A social planner in a municipality analyzes community needs and develops policies,
programs, and services to enhance social well-being and equity. They collaborate with
government agencies, nonprofits, and residents to address issues such as housing,

CC to call on Council to support hiring a social
planner for the District.

Medium

accessibility, public health, and social inclusion. Their work ensures that municipal planning Councillor Phelps Bondaroff working on this and will
considers the diverse needs of all citizens, promoting a more livable and inclusive
community.

bring this back to the CC.

Saanich does not currently employ a social planner, and as a result, the work of the social
planner is falling to other staff. For example, Council recently asked staff to explore
increasing the number of shelter beds in the District, and this work has fallen to staff to do
in addition to their current workplans. Having a dedicated staff position would allow us to
hire someone specialized in this field, with time allocated specifically to social planning.

22 District Equity Office The District is in the early stages of developing an Equity Office. Staff to connect with the Director of Corporate
Services to determine the timing of a presentation
for the CC.

Low 2026

23 Review Saanich's
Commemoration and
Celebration Calendar

Review the list of cultural events and recognitions to promote inclusion. Q: How does the District determine which 'days' to Medium
celebrate/honor, including communications and
displays? (internal and external).

24 Accessibility in Parks Explore accessibility in our parks. Recognizing that this also intersects with the work and
Terms of Reference for the Natural Areas, Parks and Trails Advisory Committee.

Liaise with Parks when issues arise. Low



 

25 Intergenerational Connectivity Look for oppportunities to foster and support intergenerational connectivity within the
District through greater application of mixed-use spaces.

Q: Can this be idea be incorporated into the Older Low
Adult Strategy?

Q: How can Saanich influence/incentivize the
building of spaces in this manner?

HOLD pending Staff review of Youth/Older Adult
Strategy timelines.

26 CRD Trail Widening CRD is upgrading key sections of the Galloping Goose and Lochside Regional Trails to
match growing demand.

Get an update on CRD trail widening and how this Low
may impact accessibility.

https://www.crd.ca/projects/current-projects-initiatives/regional-trestles-renewal-trails-
widening-and-lighting-project

Staff to investigate potential timing for an update at
CC (note: this project is currently on hold pending
BC Hydro cable replacement.

27 Conflict Resolution Resources Conflicts can sometimes occur between neighbours and often if left unchecked, these can This item is beyond the scope of the CC. Low
for Neighbours fester and worsen over time. Saanich could assemble some helpful resources for people

to direct them to conflict resolution and mediation tools to help resolve conflicts and
prevent them from escalating.

Councillor Phelps Bondaroff to take this offline.

28 Expanding DEI Training to
Community Associations etc. broadly.

The idea is to curate training for Community Groups/Associations to support ADEI more Q: Is there a list of Community Associations that
Saanich funds?

Medium

CC to ask for Council support (budget) to run
several ADEI workshops annually.

29 Transit BC Transit Victoria Future Plan + Engineering Active Transportation Plan include
elements related to bus stops and accessibility.

Engineering (Troy) provided an overview of the
Active Transportation Plan as it relates to bus stops
specifically in 2024. An field trip was also

Medium 2026

conducted at a new stop on Gorge Road.

Staff to request that Engineering provide an update
at a future CC meeting.




